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Notices 

© Agilent Technologies, Inc. 2000 and 

2010 

No part of this manual may be 

reproduced in any form or by any 

means (including electronic storage 

and retrieval or translation into a 

foreign language) without prior 

agreement and written consent from 

Agilent Technologies, Inc. as governed 

by United States and international 

copyright laws. 

Manual Part Number 

8510175900 

Edition 

Second edition, March 2011 

Printed in Australia 

Agilent Technologies, Inc. 

Errata Statement 

NOTICE: This document contains 

references to Varian. Please note that 

Varian, Inc. is now part of Agilent 

Technologies. For more information, 

go to www.agilent.com/chem. 

 

Warranty 

The material contained in this 

document is provided “as is,” and is 

subject to being changed, without 

notice, in future editions. Further, to 

the maximum extent permitted by 

applicable law, Agilent disclaims all 

warranties, either express or implied, 

with regard to this manual and any 

information contained herein, 

including but not limited to the 

implied warranties of merchantability 

and fitness for a particular purpose. 

Agilent shall not be liable for errors 

or for incidental or consequential 

damages in connection with the 

furnishing, use, or performance of 

this document or of any information 

contained herein. Should Agilent and 

the user have a separate written 

agreement with warranty terms 

covering the material in this 

document that conflict with these 

terms, the warranty terms in the 

separate agreement shall control. 

Technology Licenses 

The hardware and/or software 

described in this document are 

furnished under a license and may be 

used or copied only in accordance 

with the terms of such license. 

Restricted Rights Legend 

If software is for use in the 

performance of a U.S. Government 

prime contract or subcontract, 

Software is delivered and licensed as 

“Commercial computer software” as 

defined in DFAR 252.227-7014 (June 

1995), or as a “commercial item” as 

defined in FAR 2.101(a) or as 

“Restricted computer software” as 

defined in FAR 52.227-19 (June 1987) 

or any equivalent agency regulation or 

contract clause. Use, duplication or 

disclosure of Software is subject to 

Agilent Technologies‟ standard 

commercial license terms, and non-

DOD Departments and Agencies of the 

U.S. Government will receive no 

greater than Restricted Rights as 

defined in FAR 52.227-19(c)(1-2) (June 

1987). U.S. Government users will 

receive no greater than Limited Rights 

as defined in FAR 52.227-14 (June 

1987) or DFAR 252.227-7015 (b)(2) 

(November 1995), as applicable in any 

technical data. 

Safety Notices 

A CAUTION notice denotes a hazard. 

It calls attention to an operating 

procedure, practice, or the like that, if 

not correctly performed or adhered to, 

could result in damage to the product 

or loss of important data. Do not 

proceed beyond a CAUTION notice 

until the indicated conditions are fully 

understood and met. 

A WARNING notice denotes a 

hazard. It calls attention to an 

operating procedure, practice, or the 

like that, if not correctly performed or 

adhered to, could result in personal 

injury or death. Do not proceed 

beyond a WARNING notice until the 

indicated conditions are fully 

understood and met. 

WARNING 

CAUTION 
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Applications 

The Agilent Cary Eclipse instrument runs using the easy-to-use Cary 
Eclipse software. The Cary Eclipse software consists of various 
applications, depending on the package ordered (refer to Table 1). A 
brief description of each application is provided in Table 2. For 
detailed information about each application, refer to Chapter 3. 

Table 1 Applications included with each Cary Eclipse software package 

Package Applications 

Bio ADL Shell, Advanced Reads, Align, Concentration, GLP Administration, 

Kinetics, Lifetimes, Scan, Simple Reads, System Information and Validate  

Conc ADL Shell, Advanced Reads, Align, Concentration, GLP Administration, 

Scan, Simple Reads, System Information and Validate 

Scan ADL Shell, Advanced Reads, Align, GLP Administration, Simple Reads, 

Scan, System Information and Validate 
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Table 2. Descriptions of each Cary Eclipse software application 

Application Description Page 

ADL Shell A pre-defined template for writing ADL programs. 20 

Advanced Reads For collecting absorbance readings for multiple 

samples. 

20 

Align For aligning various instrument lamps and accessories. 20 

Concentration For quantitative analysis. 21 

GLP Administration For restricting operator access, password-protecting 

each application. 

21 

Kinetics For performing time-based measurements. 21 

Lifetimes For performing phosphorescence lifetime 

measurements. 

22 

Scan For performing wavelength scans. 22 

Simple Reads For collecting single wavelength absorbance readings. 22 

System Information For entering your company and instrument details for 

use in reports, and so on. 

23 

Validate For verifying your system performance. 23 

NOTE The Cary Eclipse software runs on the Microsoft® Windows® 98 or Windows 

NT® 4 operating systems. 
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User documentation 

You have been provided with the following documentation to help set 
up and operate your Cary Eclipse system: 

 A hardware manual, with safety practices and hazards 
information, instructions for installing and maintaining the 
components of the Cary Eclipse and troubleshooting information. 

 This software manual, with instructions for installing the Cary 
Eclipse software, an overview of the software, detailed ‘How 
To…’ procedures and software-related troubleshooting 
information. 

 Extensive online Help (provided with the Cary Eclipse software) 
containing context-sensitive Help, step-by-step instructions for 
frequently performed analyses and instructions for using any 
accessories you ordered. Refer to ‘Using the Help’ on Page 26. 

Conventions 

The following conventions are used throughout procedures in the 
documentation: 

 Menus, menu items, buttons and check boxes have been typed in 
bold. For example, ‘click OK’ and ‘From the Edit menu, choose 
Copy’.  

 ALL CAPITALS indicate keyboard commands. For example, 
‘Press ENTER’ and ‘Press SHIFT+F3’. 

A Note is used to give advice or information. 

A Tip is used to give practical hints to help you achieve the best 
possible performance from your instrument.  
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This chapter assumes you have already set up the Cary Eclipse 
instrument. The Cary Eclipse is interfaced to the computer via an 
IEEE-488 (GPIB) card. Install the Cary Eclipse software first before 
installing the ISA-GPIB or PCI-GPIB card in your computer. 

NOTE The Cary Eclipse software runs on the Microsoft Windows 98 or Windows NT 4 

operating systems. 
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Computer requirements 

The minimum computer configuration represents the absolute 
minimum on which you can run the software. This computer 
configuration may be out of manufacture, but you may want to use a 
computer you already have.  

The recommended configuration is that which you would buy new. 

Table 3. Minimum and recommended computer requirements 

Minimum Recommended 

IBM compatible IBM compatible 

Intel® Pentium® II (or compatible) 

200 MHz processor 

Intel Pentium II processor 

32 MB RAM 64 MB RAM 

200 MB free space on hard disk 500 MB free space on hard disk 

3.5 in 1.44 MB floppy disk drive 3.5 in 1.44 MB floppy disk drive 

Video card supporting 800 x 600 pixels 

resolution, high color (16 bit) mode 

Video card supporting 800 x 600 pixels 

resolution, high color (16 bit) mode 

Super VGA screen Super VGA screen 

16x CD drive 24x CD drive 

16 bit sound card 16 bit sound card 

Windows 101 key keyboard Windows 101 key keyboard 

Microsoft or compatible mouse Microsoft or compatible mouse 

One spare AT bus 16 bit ISA expansion 

slot 

One spare AT bus 16 bit ISA expansion 

slot 

Microsoft Windows 98 or Windows NT 

(including Service Pack 4 or later) 

Microsoft Windows 98 or Windows NT 

(including Service Pack 4 or later) 

NOTE If you are going to use 3D plotting and presentation, the computer should be 

equal or better than the recommended configuration. 
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Check list 

Use this check list to install the Cary Eclipse software. 

Step Reference Complete 

Install a Windows operating system and check that all devices, for 

example, sound card and CD drive are working. 

Windows operating 

system documentation 

□ 

Set the monitor screen resolution to at least 800 x 600 pixels and 

the color palette to at least High Color. 

Page 13 □ 

Windows NT only: Log on as an Administrator. Windows NT 

documentation 

□ 

Install the Windows Update disk supplied with the Cary Eclipse 

software. 

Page 14 □ 

Install the Cary Eclipse Software and Help disks. Page 14 □ 
Install the instrument interface card in the computer and connect 

the computer to the Cary Eclipse instrument. 

Hardware manual supplied 

with the instrument 

□ 

Restart the computer. Windows documentation □ 

Changing the monitor resolution 

For optimum viewing, your monitor resolution should be set to 800 x 
600 pixels (or greater) and High Color (16 bit) (or greater). 

To set the monitor resolution: 

1 Click the Windows Start, Settings and then Control Panel. 

2 Double-click the Display icon.  

3 From the ‘Display Properties’ dialog box, click the Settings tab. 

4 In the ‘Desktop area’ section, drag the sliding bar so that the 
pixel amount is set to ‘800 by 600 pixels’. (You can set it to a 
higher resolution if you wish.) 

5 In the ‘Color palette’ section, select High color (16 bit). 

6 Click OK. At the prompt, which informs you that your settings 
will be adjusted, click OK again. When asked if you wish to keep 
the setting, click Yes. 

7 You can then exit the Control Panel. 
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Windows Update disk 

NOTE The Windows Update disk will ensure that your computer system is capable of 

running all the features of the online Help. 

 

To update your software: 

1 Turn on your computer. 

NOTE If you are using Windows NT, log on as an Administrator or as a user with 

Administrator privileges. 

 

2 Insert the Windows Update disk into the CD drive. 

3 From the Windows Start menu, choose Run. The ‘Run’ dialog box 
will be displayed. 

4 Click Browse and search for your CD drive using the Browse 
dialog box. 

5 Select the file WinUpdate.exe from the root directory of the CD 
drive. Click Open and then click OK from the ‘Run’ dialog box to 
start the installation. 

6 Follow the prompts on the screen to install the Windows Update 
disk. 

Cary Eclipse software, Help and drivers 

To install the software: 

1 Insert the Cary Eclipse Software disk into the CD drive. 

NOTE Ensure that you are NOT running any Cary WinUV software when you begin 

installation of the Cary Eclipse software. This includes the System Information 

icon that may be present on your Windows task bar. 
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2 Click Install Cary Eclipse Software from the displayed dialog 
box. 

3 Follow the instructions on the screen. During installation, you 
will be asked to specify, amongst other things, the drive on which 
to install the software. 

When the installation is complete you should have a ‘Cary Eclipse’ 
program group on the desktop containing a number of icons. The 
installation also places a ‘Cary Eclipse’ folder in the ‘Start’ > 
‘Programs’ menu. 

NOTE If you are using Windows NT and did not have Administrator privileges, the 

installation will fail. To successfully complete the installation, log on again as 

an Administrator and start the installation process again. 

 

4 Remove the Cary Eclipse Software disk from the CD drive and 
insert the Cary Eclipse Help disk, as prompted. 

NOTE You will need to insert the Cary Eclipse Help disk into the CD drive each time 

you want to view videos included in the Help. 

 

5 After successful installation of the software, shut down the 
computer and install either the Agilent IEEE ISA card into the 
ISA card slot, or the National Instruments PCI-GPIB card into the 
PCI slot. 

GPIB driver  

The GPIB driver must be manually installed depending on the type of 
GPIB card (that is, ISA or PCI) and the operating system. To 
determine whether you have an ISA or a PCI card, take a look at the 
card. Cards marked with the Agilent logo are ISA_GPIB cards, while 
cards marked ‘PCI-GPIB’ from National Instruments are PCI-GPIB 
cards.  
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Once you have determined the type of card you have, refer to the 
following instructions that are relevant to your card and operating 
system. 

ISA for Windows 98 

1 Insert the Cary Eclipse Software disk into the CD drive. From the 
dialog box displayed at startup, click the Exit button. 

2 From the Windows Start menu, point to Settings and choose 
Control Panel. 

3 In the Control Panel window, double-click the Add New 
Hardware icon. The ‘Add New Hardware Wizard’ is displayed. 

4 Click Next to begin the hardware installation process.  

5 Click Next again. 

6 Select No, I want to select the hardware from a list and then 
click Next. 

7 From the ‘Hardware types’ list, select Other devices and then 
click Next. 

8 Click the Have Disk button. 

9 Enter your CD drive letter (for example, ‘D’) and click OK. 
Follow the instructions on the screen to complete the process.  

10 When you are prompted to restart the computer, click Yes.  

Once you have restarted the computer, you should check that there 
are no conflicts with other devices.  

To do this: 

1 From the Windows Start menu, point to Settings and choose 
System. 

2 In the ‘System Properties’ dialog box, click the Device Manager 
tab to display the ‘Device Manager’ page. 

3 In the ‘Device’ list, highlight VarianGpibCard and click the 
Properties button to check for conflicts with other devices. 

PCI for Windows 98 

The driver is automatically installed during software installation. 
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ISA for Windows NT 

The driver is automatically installed during software installation. 

PCI for Windows NT 

The National instruments driver is automatically installed during 
software installation. However, it must be re-configured in order to 
run the Eclipse. 

1 After installing the PCI GPIB Card, restart the computer and log 
on as an Administrator or as a user with Administrator privileges 
to successfully install the software. 

2 From the Windows Start menu, point to Settings and choose 
Control Panel. 

3 In the Control Panel window, double-click the GPIB icon. The 
GPIB Configuration Utility is displayed. 

4 From the list of all the GPIB boards and device names, select 
GPIB0. 

5 Click the Board Type button and from the list that is displayed, 
select PCI-GPIB. Click OK. 

6 Click the Configure button to display the ‘PCI-GPIB 
Configuration’ dialog box. 

7 In the Serial Number drop-down list, select the serial number for 
the Eclipse board if more than one PCI card is installed. Then 
click OK. 

8 From the ‘GPIB Configuration’ dialog box, click OK to save your 
changes and exit the utility. 

Late breaking news 

Before proceeding further, you should read the Late Breaking News 
documents supplied with the software. The documents contain the 
latest release information and important notes. 
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Starting the software 

To start the Cary Eclipse software click the Start > Programs > 
Cary Eclipse and then select the desired application. 

After the initial Cary Eclipse flash screen appears, the selected 
application will open (refer to Chapter 3 for information on the 
available applications). 

Re-installing 

To re-install the Cary Eclipse software: 

1 Close all Windows applications. 

2 Click Start > Control Panel. 

3 In the ‘Control Panel’ window, double-click the Add/Remove 
Programs icon. The ‘Add/Remove Programs Properties’ dialog 
box will be displayed. 

4 Choose Eclipse from the list and then click the Add/Remove 
button. 

5 Follow the prompts to uninstall the software. Select No to all 
when asked to remove shared files. 

6 Insert the Cary Eclipse Software disk into the CD drive and 
choose Install Software from the displayed window. 

7 Follow the instructions to complete the installation. 

8 You must restart your computer before running the software. 

NOTE If you are using Windows NT with a PCI GPIB card, re-configure the card as 

described on Page 17. 
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This chapter provides a brief introduction to the Cary Eclipse 
software to help you familiarize yourself with its use. For more 
detailed information about the applications and their settings, refer 
to the extensive online Help (see Page 26 for more information about 
using the Help).  
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ADL Shell 

The Applications Development Language (ADL) is a built-in 
spectroscopy language supplied with the Cary Eclipse software. The 
ADL Shell gives you a pre-defined template for writing ADL 
programs. Rather than needing to write the code for basic functions 
such as graphing and filing, the ADL Shell has a number of these 
commands already implemented. In other words, you do not have to 
design your own interface — you can use the ADL Shell to provide the 
basic functionality and build on that. 

Advanced Reads 

The Advanced Reads application can be used to set up and read 
multiple samples in a single run. 

The features of the application include: 

 Enables you to find the mean of multiple readings of the sample 
solution. 

 Enables you to find the mean of multiple sample aliquots of the 
sample solution. 

 Comprises three data modes — fluorescence, phosphorescence 
and chemi-/bio-luminescence. 

 Can be used in conjunction with a range of accessories. 

Align 

The Align application enables you to perform alignment procedures. 
For your Cary Eclipse instrument to operate at peak performance, 
you must ensure that the lamps are correctly aligned in the optical 
path. Poor lamp alignment or the use of old, failing lamps may 
decrease the signal-to-noise ratio and adversely affect the 
performance of your instrument. 

You must also monitor the lamp usage, as these have a finite lifetime 
and must be changed on a regular basis. When you notice that your 
data is becoming ‘noisy’ or you experience a lamp failure error, you 
will need to change the appropriate lamp. 
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The Align application can also be used to align the Microplate 
accessory. 

Concentration 

The Concentration application is used to determine the 
concentration of an absorbing sample, using up to a 30-point 
calibration for quantitative analysis. 

The application allows you to select from several curve fit types for 
the calibration: linear, direct linear and quadratic. Based on the fit 
type selected, it then calculates the coefficients of the fit equation 
and the correlation coefficient and prints these in the Report area. 

The concentration values of samples are then obtained by measuring 
each sample against the calibrated fit equation. The result obtained is 
the concentration of the sample and can be viewed in the Report 
area. 

GLP Administration 

The GLP Administration application is used to protect the system 
from unauthorized use, enabling application-specific privileges to be 
turned on or off by the system administrator. 

If this application is operational, users will need to be registered, 
have a user name and a valid password before they can access the 
various privileges. 

Kinetics 

The Kinetics application is used to measure the increase or decrease 
in emission intensity as a function of time. From this you can obtain 
an intensity versus time plot. 

The features of the application include: 

 Calculation of Zero Order, First Order and Second Order reaction 
rates from intensity versus time data. 

 Selectable time window for calculation. 
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 Overlay of the best-fit line on raw data. 

 Auto or manual estimates for the First Order and Second Order 
Marquardt fitting. 

Lifetimes 

The Lifetimes application is used to measure phosphorescence 
lifetimes, and therefore is only available in phosphorescence mode. 

The Lifetimes application measures the average amount of time a 
molecule remains in the excited state following excitation. Where: 

 Lifetimes (time resolved) 

 A + Excitation -> A*  

 A* -> A + Emission 

It is a time-based measurement (like Kinetics) where the change in 
intensity is usually due to uni-molecular processes.  

The shape of the decay curve produced by a Lifetimes measurement 
is sensitive to the environment that the molecule is in. For this 
reason, it is often used as a probe technique to determine what the 
molecule is experiencing. 

Scan 

The Scan application enables you to scan samples across a 
wavelength or wavenumber range and manipulate the collected data. 
You can choose various display modes for the collected data 
depending on the type of sample you are measuring and the Cary 
Eclipse accessories that you are using. 

Simple Reads 

The Simple Reads application is used to perform simple fluorescence, 
phosphorescence and bio/chemi-luminescence readings of samples. 
In addition, simple mathematical operations can be performed (via 
the ‘User Collect’ option) on readings performed at multiple 
wavelengths. 
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System Information 

The System Information application enables you to control 
information that is used by all applications such as company details, 
e-mail host options and the way in which hints are displayed in the 
various applications. The information stored here is then made 
available to the reporting functions of all the other applications. For 
example, if you store your company’s logo in System Information, it 
can be printed on a report issued from any application. 

Validate 

The Validate application enables you to carry out a number of 
performance tests to verify that the system is performing according 
to specification.  

An optional Validation documentation package is also available from 
Agilent, providing detailed information on the functional 
specification and development process of the Cary Eclipse system. It 
also contains detailed DQ/IQ/OQ documentation to assist your initial 
and on-going validation activities. 

File name extensions 

The various Cary Eclipse software files, such as method files, report 
files and graphic files are saved with a four-letter file name extension 
that represents the type of file, and the application that created the 
file. 

The file name extensions for each file type are: 

File type File name extension 

Batch FB** 

Data FD** 

Graph Template FG** 

Methods FM** 

Report FR** 

where ** equals the Cary Eclipse application code, used to 
distinguish between different applications.  
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The application codes are: 

Application File name extension 

Advanced Reads **AB 

Concentration **CN 

Kinetics **KN 

Lifetimes **LT 

Scan **SW 

Simple Reads **SR 

Validate **VO 

For example, a method file from the Concentration application would 
have the file name extension ‘*.fmcn’. 

NOTE To allow you to identify the different file types in Windows Explorer, you need to 

disable the Windows option that hides file name extensions. To do this, choose 

„Options‟ from the „View‟ menu in Windows Explorer and clear the „Hide MS-

DOS file name extensions for file types that are registered‟ option on the „View‟ 

page. 
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Interface 

A typical Cary Eclipse screen is as follows: 

 

Hint text 

You can obtain ‘Hint text’ for a particular control or field by 
positioning the pointer over the control/field name for a short time. 
After a short delay, a brief hint will appear describing what the 
control or field does. If you hold the pointer over a numeric entry 
field, the valid range for that field will appear. 

If these hints do not appear, choose ‘Hints’ from the ‘View’ menu to 
enable them. Conversely, if the hint text is enabled and you wish to 
turn it off, choose ‘Hints’ from the ‘View’ menu. 

NOTE You can alter the properties of the hints, such as the length of the delay before 

hints appear, on the „Hints‟ page in the System Information application. 
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Using the Help 

The Cary Eclipse software includes extensive online Help, which 
should be your primary source of information on how to use your 
Cary Eclipse system. It contains descriptions of the various windows, 
dialog boxes and fields that make up the software, as well as step-by-
step instructions to help you perform various tasks. It also includes 
‘Tips and Tricks’, ‘Troubleshooting’ and ‘Contacts’ sections in case 
you encounter difficulties using the software. 

Since the Help system is so extensive, it is advisable to familiarize 
yourself with the contents of the Help by viewing the Help Home 
page. There are a number of ways to open the Help Home page: 

 Click the Windows ‘Start’ button, ‘(All) Programs’, ‘Cary Eclipse’, 
‘Cary Eclipse Help’. 

 Double-click the ‘Cary Eclipse’ folder on the desktop and double-
click ‘Cary Eclipse Help’. 

 Click ‘Help Topics’ on the ‘Help’ menu when in an application to 
go to the Help Home page. 

You can also make the Help open on the appropriate page containing 
information relevant to the currently open application or dialog box: 

 Click ‘(Application) Help’ (for example, ‘Scan Help’) on the ‘Help’ 
menu when in an application to go to the Home page for that 
application. 

 Click the ‘Help’ button on a dialog box to go to information about 
that dialog box. 

 Press F1 to go to information about the current dialog box. 

Navigating 

You can move around the Help using the ‘Contents’ on the left of the 
Help window. 

NOTE To display the Contents, click the „Show‟ button at the top of the Help window. 
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The Contents sections are accessed by clicking the icons and 
associated text: 

 To expand/contract a section in the Contents list, double-click 
the ‘folder’ icon for that section, or click the ‘+’/’-’ symbol next to 
the icon. 

 To display a topic, click the text associated with that topic. 

The topics in the Help are often hyperlinked to other related 
information. To return to the previous topic after clicking a 
hyperlink, click the ‘Back’ button at the top of the Help window. 

Searching  

You can quickly search the Help system for specific information 
using key words. 

To search for information on a particular subject: 

1 Click the Search tab (next to the ‘Contents’ tab). 

2 Type the word(s) you want to search for and click the List Topics 
button or press RETURN to list all the relevant pages containing 
the search word. 

The number of topics found will be displayed. You can view the 
topics in alphabetical order by clicking ‘Title’ at the top of the list, or 
in the order they appear in the Help by clicking ‘Rank’. 

3 Select the desired topic from the list and then click the Display 
button. Alternatively, double-click the topic. All occurrences of 
the key word will be highlighted. 

4 If this does not provide the information you require, enter a more 
specific word or additional words in the key words field and try 
again. Click the right arrow symbol to the right of the keywords 
field and select any of these words AND, OR, NEAR and NOT to 
place between your keywords.  
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TIP Another way to narrow your search is to use the check boxes at the bottom of 

the Search page. For example, selecting „Search titles only‟ will only list those 

Help topics containing the key word in the title. 

Within a page 

You can skip to a section of interest in a Help page by searching for a 
relevant word. 

To find a key word within a Help page: 

1 Click anywhere on the Help page. 

2 Press CONTROL+F to open the ‘Find’ dialog box. 

3 In the ‘Find what:’ field, enter the word you wish to look for. 

4 If required, limit the Find by selecting an option such as ‘Match 
case’. (This option will only find the words that appear in the 
same letter case (for example, all lower case) as the entered key 
word. 

5 Select the Direction of the Find. Select ‘Up’ to search for the key 
word from the bottom of the page upwards, or ‘Down’ to start the 
Find from the top of a page. 

6 Click the Find Next button or press ENTER to begin the Find. 
The first occurrence of the designated word will be highlighted.  

7 Click the Find Next button or press ENTER repeatedly to jump to 
other occurrences of the key word. When all instances of the 
word have been found, the message ‘Finished searching the 
document’ will be displayed. 
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Tracking „favorite‟ topics 

You can keep a list of useful Help topics using the ‘Favorites’ option. 

If you come across a topic you may wish to refer to again: 

1 Click the Favorites tab. The title of the page currently visible will 
be present in the ‘Current topic:’ field at the bottom of this tab. 

2 Click the Add button to include this topic to the Favorites list. 

If you would like to view this page later on, you can simply click the 
‘Favorites’ tab and highlight the topic of interest by clicking it, then 
click the ‘Display’ button. (Alternatively, double-click the topic.) 

If a topic is no longer required in the Favorites list, highlight it then 
click the ‘Remove’ button. 

Printing 

You can print one or more Help topics for a particular application. 

To obtain a printed copy of the current Help page: 

1 Click the Print button at the top of the Help window. The ‘Print’ 
dialog box will be displayed. 

2 Click Print. 

To obtain a hard copy of multiple Help pages: 

1 Right-click on the topic in the ‘Contents’ page, and choose Print. 

2 Click Print the selected heading and all sub-topics. 
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This chapter provides step-by-step instructions on how to perform 
common operating procedures using your Cary Eclipse instrument 
and various software applications. For more detailed information on 
the software applications or your Cary Eclipse instrument, refer to 
the extensive online Help (see Page 26 for information on using the 
Help). 

Advanced Reads 

The following Advanced Reads procedures are described: 

 Manually reading samples 

 Reading samples using the Multicell Holder 

Manually read samples 

This procedure demonstrates how to perform a fluorescence read 
using no accessories. Follow the steps, adjusting them to meet the 
requirements of your particular data collection.  
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To perform a fluorescence read: 

1 Start the Advanced Reads application 

Click the Windows Start button, Programs, Cary Eclipse and then 
choose Advanced Reads. The Advanced Reads application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Advanced Reads application. 

 

2 Set up the data collection parameters 

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters 

Setup dialog box | Cary page 

a In the ‘Data mode’ field set the ‘Mode’ to Fluorescence. 

b In the ‘Ex. Wavelength’ field, set the wavelength of the 
excitation monochromator, which is the wavelength value at 
which you want to excite your sample. 

c In the ‘Em. Wavelength’ field set the wavelength of the 
emission monochromator, which is the wavelength value at 
which your sample emits. 

d Set the slit width of the excitation monochromator.  

NOTE As a general rule, at a fixed emission slit width, increasing the excitation slit 

width will result in an increase in the fluorescence excitation intensity. 

 

e Set the slit width of the emission monochromator. 
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NOTE As a general rule, at a fixed excitation slit width, a two-fold increase in the 

emission slit width will result in a four-fold increase in the emission intensity. 

Accordingly, a two-fold decrease in the emission slit width will result in a four-

fold decrease in the emission intensity. 

 

f In the ‘Ave. (averaging) Time’ field, enter the required value. 
A good starting point is 0.1 seconds. 

4 Set up the filter and voltage options 

Setup dialog box | Options page  

a Click the Options tab. The ‘Options’ page will be displayed.  

b Set the ‘Excitation filter’ for the concentration measurement. 
It is recommended that you set the filter to Auto (the default 
setting). This will automatically move the filter wheel to the 
appropriate position for the selected excitation wavelength. 

c Set the ‘Excitation filter’ and the ‘Emission filter’ for the 
concentration measurement. In order to minimize steps in 
the spectra, it is recommended that you set the filter to Open 
(the default setting). 

d Set the ‘PMT Detector Voltage’. The setting you choose will 
depend upon your sample. For example, a ‘Low’ setting is 
recommended for highly-emitting samples, while a ‘High’ 
setting is recommended for low-emitting samples.  

5 Make sure that no accessories are selected 

Setup dialog box | Accessories page 

Click the Accessories tab and ensure that no accessories are 
selected. 

6 Set up your samples 

Setup dialog box | Samples page 

a Click the Samples tab to display the ‘Samples’ page. This 
page enables you to enter a list of sample names that will be 
used during your analysis.  
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b Enter the number of samples that you are going to use in the 
‘No. of Samples’ field. The table below this field will expand 
or contract to match your choice. 

c In the ‘Sample names’ table, enter the name of each sample. 
You can enter up to 20 characters for each name. 

If you would like the samples to have the same name with a different 
numeric extension, enter the name in the first sample position and 
then click the ‘Increment’ button. 

7 Set up reporting and printing requirements 

Setup dialog box | Reports page 

a Click the Reports tab. The ‘Reports’ page will be displayed. 
You can use this page to specify your reporting requirements 
for this method. 

b Enter your name in the ‘Name’ field. 

c Optional: Enter a comment relating to your experiment in the 
‘Comment’ field.  

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

  ‘Parameters’ to include your experimental parameters in the 
report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as the Report area. However if „Auto Print‟ is not 

selected, the report will only be sent to the Report area. 

 

8 Set up storage of collected data 

Setup dialog box | Auto Store page 

a Click the Auto Store tab. The ‘Auto Store’ page will be 
displayed. 

b Set the ‘Storage’ option to Off. The method, collected data 
and report will not be automatically saved. However, you can 
manually save it all at the end of the collection. 
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9 Set up visual system monitoring 

Select the Show Status Display check box on any of the ‘Setup’ pages 
to display various information fields on your current reaction. 

10 Finish setup 

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

11 Zero the instrument 

a Place a blank in the sample compartment. 

b From the Advanced Reads application window, click Zero to 
zero the system. 

12 Read the samples 

a Click the Start button. The ‘Sample Selection’ dialog box will 
be displayed. 

b Ensure that the samples you wish to read are in the ‘Selected 
for Analysis’ list and click OK. 

c The ‘Present Sample’ dialog box will be displayed to prompt 
you to place the appropriate sample in the sample 
compartment. Click OK to read the sample. (If replicates 
have been nominated, the result is reported after the final 
sample replicate is read.) 

d Repeat c for the remaining samples. 

13 Save your data 

a From the File menu, choose Save Data As. The ‘Save As’ 
dialog box will be displayed. 

b Enter the ‘File name’ for this read. 

c Click Save. The data will be stored as a method file. 
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Read samples using the Multicell Holder 

This procedure demonstrates how to read samples using the Multicell 
Holder accessory. Follow the steps, adjusting them to meet the 
requirements of your particular data collection.  

To read samples using the Multicell Holder: 

1 Start the Advanced Reads application 

Click the Windows Start button, Programs, Cary Eclipse and then 
choose Advanced Reads. The Advanced Reads application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Advanced Reads application. 

 

2 Set up the data collection parameters 

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters 

Setup dialog box | Cary page 

a In the ‘Data mode’ field, Set the ‘Mode’ to Fluorescence. 

b In the ‘Ex. Wavelength’ field, set the wavelength of the 
excitation monochromator, which is the wavelength value at 
which you want to excite your sample. 

c In the ‘Em. Wavelength’ field, set the wavelength of the 
emission monochromator, which is the wavelength value at 
which your sample emits. 

d Set the slit width of the excitation monochromator. 

NOTE As a general rule, at a fixed emission slit width, increasing the excitation slit 

width will result in an increase in the fluorescence excitation intensity. 

 

e Set the slit width of the emission monochromator.  
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NOTE As a general rule, at a fixed excitation slit width, a two-fold increase in the 

emission slit width will result in a four-fold increase in the emission intensity. 

Accordingly, a two-fold decrease in the emission slit width will result in a four-

fold decrease in the emission intensity. 

 

f In the ‘Ave. (averaging) Time’ field, enter the required value. 
A good starting point is 0.1 seconds. 

4 Set up the filter and voltage options 

Setup dialog box | Options page 

a Click the Options tab. The ‘Options’ page will be displayed. 

b Set the ‘Excitation filter’ for the concentration measurement. 
It is recommended that you set the filter to Auto (the default 
setting). This will automatically move the filter wheel to the 
appropriate position for the selected excitation wavelength. 

c Set the ‘Excitation filter’ and the ‘Emission filter’ for the 
concentration measurement. In order to minimize steps in 
the spectra, it is recommended that you set the filter to Open 
(the default setting). 

d Set the ‘PMT Detector Voltage’. The setting you choose will 
depend upon your sample. For example, a ‘Low’ setting is 
recommended for highly-emitting samples, while a ‘High’ 
setting is recommended for low-emitting samples. 

5 Set up the Multicell Holder accessory 

Setup dialog box | Accessories page 

a Click the Accessories tab to display the ‘Accessories’ page. 

b Select the Multicell Holder check box to enable the 
accessory. 

c Ensure that you have this accessory installed before starting 
the run. 

d In the ‘Cell Holder’ diagram, select the cells you require. 

e Select the Multi Zero check box to enable the ‘Multi Zero’ 
facility. 
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f Make sure that no other accessories are selected on this page.  

6 Set up your samples 

‘Setup dialog box | Samples page 

a Click the Samples tab to display the ‘Samples’ page. This 
page enables you to enter a list of sample names that will be 
used during your analysis. 

b Enter the number of samples that you are going to use in the 
‘No. of Samples’ field. The table below this field will expand 
or contract to match your choice. 

c In the ‘Sample names’ table, enter the name of each sample. 
You can enter up to 20 characters for each name. 

If you would like the samples to have the same name with a different 
numeric extension, enter the name in the first sample position and 
then click the ‘Increment’ button. 

7 Set up reporting and printing requirements 

Setup dialog box | Reports page 

a Click the Reports tab. The ‘Reports’ page will be displayed. 
You can use this page to specify your reporting requirements 
for this method. 

b Enter your name in the ‘Name’ field. 

c Optional: Enter a comment relating to your experiment in the 
‘Comment’ field. 

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as the Report area. However, if „Auto Print‟ is not 

selected, the report will only be sent to the Report area. 
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8 Set up storage of collected data 

Setup dialog box | Auto Store page 

a Click the Auto Store tab. The ‘Auto Store’ page will be 
displayed. 

b Set the ‘Storage’ option to Off. The method, collected data 
and report will not be automatically saved. However, you can 
manually save it all at the end of the collection. 

9 Set up visual system monitoring 

Select the Show Status Display check box on any of the ‘Setup’ pages 
to display various information fields on your current reaction. 

10 Finish setup 

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

11 Zero the instrument 

a Place a blank in the sample compartment. 

b From the Advanced Reads application window, click Zero to 
zero the system. 

12 Read the samples 

a Click the Start button or choose Start from the Commands 
menu. The ‘Sample Selection’ dialog box will be displayed. 

b Select the samples to be used in the analysis. By default, all 
samples are selected. 

c Click OK to close The ‘Sample Selection’ dialog box. 

d The ‘Cell Loading Guide’ dialog box will be displayed. Load 
your samples as indicated, then click OK to start reading the 
samples. If additional ‘Cell Loading Guide’ dialog boxes are 
displayed, continue to load your samples as indicated and 
click ‘OK’ to continue loading the samples. The Cary Eclipse 
will measure the samples.  
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Concentration 

The following Concentration procedures are described: 

 Performing a calibration 

 Performing a calibration and manually measuring concentrations 

 Performing a calibration and measuring concentrations using the 
Multicell Holder 

 Manually measuring concentrations 

Perform a calibration 

This procedure demonstrates how to perform and store a 
fluorescence multi-standard calibration, without measuring any 
sample concentrations. Follow the steps, adjusting them to meet the 
requirements of your particular data collection.  

To perform a calibration: 

1 Start the Concentration application  

Click the Windows Start button, Programs, Cary Eclipse and then 
choose Concentration. The Concentration application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Concentration application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters  

Setup dialog box | Cary page  

a In the ‘Data mode’ field, set the ‘Mode’ to Fluorescence. 
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b In the ‘Ex. Wavelength’ field, set the wavelength of the 
excitation monochromator, which is the wavelength value at 
which you want to excite your sample. 

c In the ‘Em. Wavelength’ field, set the wavelength of the 
emission monochromator, which is the wavelength value at 
which your sample emits. 

d Set the slit width of the excitation monochromator. 

NOTE As a general rule, at a fixed emission slit width, increasing the excitation slit 

width will result in an increase in the fluorescence excitation intensity. 

 

e Set the slit width of the emission monochromator. 

NOTE As a general rule, at a fixed excitation slit width, a two-fold increase in the 

emission slit width will result in a four-fold increase in the emission intensity. 

Accordingly, a two-fold decrease in the emission slit width will result in a four-

fold decrease in the emission intensity. 

 

f In the ‘Ave. (averaging) Time’ field, enter the required value. 
A good starting point is 0.1 seconds. 

4 Set up the display, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab. The ‘Options’ page will be displayed. 

b Enter the minimum and maximum ‘Y values’ to be displayed 
on the graph axis during the data collection.  

c Set the ‘Excitation filter’ for the concentration measurement. 
It is recommended that you set the filter to Auto (the default 
setting). This will automatically move the filter wheel to the 
appropriate position for the selected excitation wavelength. 

d Set the ‘Excitation filter’ and the ‘Emission filter’ for the 
concentration measurement. In order to minimize steps in 
the spectra, it is recommended that you set the filter to Open 
(the default setting). 
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e Set the EHT or sample detector PMT. The setting you choose 
will depend upon your sample. For example, a ‘Low’ setting 
is recommended for highly-emitting samples, while a ‘High’ 
setting is recommended for low-emitting samples. 

5 Make sure that no accessories are selected 

Setup dialog box | Accessories page 

Click the Accessories tab and en sure that no accessories are 
selected. 

6 Set up the calibration  

Setup dialog box | Standards page  

a Click the Standards tab to access the ‘Standards’ page where 
you can set up the standards and their parameters associated 
with the data collection. 

b Set the appropriate ‘Units’ for your standards for reporting 
purposes. 

c In the ‘Standards’ field, enter the number of standards that 
you are using in your calibration. The table below this field 
will expand or contract to match your choice. 

d In the ‘Standards’ table, enter the concentration of each 
standard in the ‘Conc.’ column. 

e Select the type of curve fitting required for your calibration 
under ‘Fit Type’. 

f Enter the required R2 value or correlation coefficient in the 
‘Min R2’ field. The closer the number is to 1.000 the better the 
fit. Typically, 0.95 is used. 

7 Set up your samples  

Setup dialog box | Samples page  

As this is a calibration only, set the ‘No. of Samples’ field to ‘0’. 

8 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method. 

b Enter your name in the ‘Name’ field. 
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c Optional: Enter a comment relating to your experiment in the 
‘Comment’ field. 

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report.  

 ‘Graph’ to include a calibration graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as the Report area. However if „Auto Print‟ is not 

selected, the report will only be sent to the Report area and can be viewed by 

choosing „Report‟ from the „View‟ menu. 

 

9 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page. 

b Set the ‘Storage’ option to Off. The method (with calibration), 
collected data and report will not be automatically saved. 
However, you can manually save it all at the end of the 
collection. 

c Select the ‘Auto Convert’ option you require. If you select 
‘ASCII (csv)’ or ‘ASCII (csv) with log’, at the end of the data 
collection the system will automatically generate a report and 
store the data both in the Cary Eclipse format as well as 
ASCII XY pairs format. The data file will be saved in the 
current folder. 

10 Set up visual system monitoring  

Select the Status Display check box on any of the ‘Setup’ pages to 
display various information fields on your current reaction. 

11 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and clear the ‘Setup’ dialog box. 
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12 Zero the instrument  

a From the Concentration application window, click the Zero 
button to zero the system. Alternatively, choose Zero from 
the Commands menu. The ‘Zero’ dialog box will be displayed. 

b Place a blank in the sample compartment and click OK. 

13 Perform the calibration  

a Click the Start button or choose Start from the Commands 
menu. The ‘Standard/Sample Selection’ dialog box will be 
displayed. 

b Select the standards and samples to be used in the analysis. 
By default, all standards are selected. 

TIP If you accidentally included samples on the „Samples‟ page, highlight them and 

use the arrow keys to move them to the „Solutions Available‟ list so they will not 

be read. 

 

c Click OK to close The ‘Standard/Sample Selection’ dialog 
box. 

d The ‘Present Standard’ dialog box will be displayed to 
prompt you to place the appropriate standard in the sample 
compartment. Click OK to measure the standard. 

e Repeat Step d until you have measured all the standards. The 
Cary Eclipse will calculate the calibration and the correlation 
coefficient.  

NOTE If the set correlation coefficient (R2) value is not met, the Cary Eclipse will prompt 

you with „Min R2 test failed‟. 

 

14 Save your calibration 

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this Concentration run. 

c Click Save and save the method with the calibration as a 
Method (*.fmcn) file. 
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Perform a calibration and manually measure concentrations 

This procedure demonstrates how to perform a fluorescence multi-
standard calibration and measure sample concentrations using no 
accessories. Follow the steps, adjusting them to meet the 
requirements of your particular data collection.  

To perform a calibration and manually measure concentrations: 

1 Start the Concentration application  

Click the Windows Start button, Programs, Cary Eclipse and then 
choose Concentration. The Concentration application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Concentration application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters 

Setup dialog box | Cary page  

a In the ‘Data mode’ field, set the ‘Mode’ to Fluorescence. 

b In the ‘Ex. Wavelength’ field, set the wavelength of the 
excitation monochromator, which is the wavelength value at 
which you want to excite your sample. 

c In the ‘Em. Wavelength’ field, set the wavelength of the 
emission monochromator, which is the wavelength value at 
which your sample emits. 

d Set the slit width of the excitation monochromator. 

NOTE As a general rule, at a fixed emission slit width, increasing the excitation slit 

width will result in an increase in the fluorescence excitation intensity. 
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e Set the slit width of the emission monochromator. 

NOTE As a general rule, at a fixed excitation slit width, a two-fold increase in the 

emission slit width will result in a four-fold increase in the emission intensity. 

Accordingly, a two-fold decrease in the emission slit width will result in a four-

fold decrease in the emission intensity. 

 

f In the ‘Ave. (averaging) Time’ field, enter the required value. 
A good starting point is 0.1 seconds. 

4 Set up the display, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab. The ‘Options’ page will be displayed. 

b Enter the minimum and maximum ‘Y values’ to be displayed 
on the graph axis during the data collection. 

c Set the ‘Excitation filter’ for the concentration measurement. 
It is recommended that you set the filter to Auto (the default 
setting). This will automatically move the filter wheel to the 
appropriate position for the selected excitation wavelength. 

d Set the ‘Excitation filter’ and the ‘Emission filter’ for the 
concentration measurement. In order to minimize steps in 
the spectra, it is recommended that you set the filter to Open 
(the default setting). 

e Set the EHT or sample detector PMT. The setting you choose 
will depend upon your sample. For example, a ‘Low’ setting 
is recommended for highly-emitting samples, while a ‘High’ 
setting is recommended for low-emitting samples. 

5 Make sure that no accessories are selected 

Setup dialog box | Accessories page 

Click the Accessories tab and ensure that no accessories are 
selected. 
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6 Set up the calibration  

Setup dialog box | Standards page  

a Click the Standards tab to access the ‘Standards’ page where 
you can set up the standards and their parameters associated 
with the data collection. 

b Set the appropriate ‘Units’ for your standards for reporting 
purposes. 

c In the ‘Standards’ field, enter the number of standards that 
you are using in your calibration. The table below this field 
will expand or contract to match your choice. 

d In the ‘Standards’ table, enter the concentration of each 
standard in the ‘Conc.’ column. 

e Select the type of curve fitting required for your calibration 
under ‘Fit Type’. 

f Enter the required R2 value or correlation coefficient in the 
‘Min R2’ field. The closer the number is to 1.000 the better the 
fit. Typically, 0.95 is used. 

7 Set up your samples  

Setup dialog box | Samples page  

a Click the Samples tab to display the ‘Samples’ page. This 
page enables you to enter a list of sample names that will be 
used during your analysis. 

b Enter the number of samples that you are going to use in the 
‘No. of Samples’ field. The table below this field will expand 
or contract to match your choice. 

c In the ‘Sample names’ table, enter the name of each sample. 
You can enter up to 20 characters for each name. 

If you would like the samples to have the same name with a different 
numeric extension, enter the name in the first sample position and 
then click the ‘Increment’ button. 

8 Set up weight and volume correction  

a Select the Weight/Volume Corrections check box. 
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b Enter the theoretical sample weight in the ‘Method Weight’ 
field. This is the weight of the sample specified in your 
method. (The Actual Weight is entered for each sample in the 
‘Sample Names’ list.) 

c Enter the units in the ‘Weight Units’ field. 

d Enter the theoretical sample volume in the ‘Method Volume’ 
field. This is the volume to which the method tells you to 
make the sample. (The Actual Volume is entered for each 
sample in the ‘Sample Names’ list.) 

e Enter the units in the ‘Volume Units’ field. 

f In the ‘Sample Names’ table, enter the ‘Actual Weight’ and 
‘Actual Volume’ for each sample. 

9 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method. 

b Enter your name in the ‘Name’ field. 

c Optional: Enter a comment relating to your experiment in the 
‘Comment’ field. 

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report.  

 ‘Graph’ to include a calibration graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as the Report area. However if „Auto Print‟ is not 

selected, the report will only be sent to the Report area and can be viewed by 

choosing „Report‟ from the „View‟ menu. 
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10 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page. 

b Set the ‘Storage’ option to Off. The method (with calibration), 
collected data and report will not be automatically saved. 
However, you can manually save it all at the end of the 
collection. 

c Select the ‘Auto Convert’ option you require. If you select 
‘ASCII (csv)’ or ‘ASCII (csv) with log’, at the end of the data 
collection the system will automatically generate a report and 
store the data both in the Cary Eclipse format as well as 
ASCII XY pairs format. The data file will be saved in the 
current folder. 

11 Set up visual system monitoring  

Select the Status Display check box on any of the ‘Setup’ pages to 
display various information fields on your current reaction. 

12 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

13 Zero the instrument  

a From the Concentration application window, click the Zero 
button to zero the system. Alternatively, choose Zero from 
the Commands menu. The ‘Zero’ dialog box will be displayed. 

b Place a blank in the sample compartment and click OK. 

14 Perform the calibration  

a Click the Start button or choose Start from the Commands 
menu. The ‘Standard/Sample Selection’ dialog box will be 
displayed. 

b Select the standards and samples to be used in the analysis. 
By default, all standards and samples are selected. 

c Click OK to close The ‘Standard/Sample Selection’ dialog 
box. 
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d The ‘Present Standard’ dialog box will be displayed to 
prompt you to place the appropriate standard in the sample 
compartment. Click OK to measure the standard. 

e Repeat Step d until you have measured all the standards. The 
Cary Eclipse will calculate the calibration and the correlation 
coefficient. 

NOTE If the set correlation coefficient (R2) value is not met, the Cary Eclipse will prompt 

you with „Min R2 test failed‟. When you click „OK‟, the Cary Eclipse will then 

prompt you with „There is no valid calibration. Proceed in Intensity (a.u.)?‟ If you 

click „Cancel‟, the Concentration run will finish. If you click „OK‟, the Cary Eclipse 

will measure the intensity of any presented samples, but will not generate a 

concentration. 

 

15 Measure sample concentration  

a Once all the standards have been read, the ‘Present Sample’ 
dialog box will be displayed to prompt you to place the 
appropriate sample in the sample compartment. Click OK to 
measure the sample and calculate its concentration. (If 
replicates have been nominated, then the concentration is 
calculated after the final sample replicate is read.) 

b Repeat Step a for the remaining samples. 

16 Save your data  

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this Concentration run. 

c Click Save. The collected data will be stored as a Batch file. 
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Perform a calibration and measure concentrations using the Multicell 

Holder 

This procedure demonstrates how to perform a fluorescence multi-
standard calibration and measure sample concentrations using the 
Multicell Holder. Follow the steps, adjusting them to meet the 
requirements of your particular data collection.  

To perform a calibration and measure concentrations using the 
Multicell Holder: 

1 Start the Concentration application  

Click the Windows Start button, Programs, Cary Eclipse and then 
choose Concentration. The Concentration application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Concentration application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters 

Setup dialog box | Cary page  

a In the ‘Data mode’ field, set the ‘Mode’ to Fluorescence. 

b In the ‘Ex. Wavelength’ field, set the wavelength of the 
excitation monochromator, which is the wavelength value at 
which you want to excite your sample. 

c In the ‘Em. Wavelength’ field, set the wavelength of the 
emission monochromator, which is the wavelength value at 
which your sample emits. 

d Set the slit width of the excitation monochromator. 
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NOTE As a general rule, at a fixed emission slit width, increasing the excitation slit 

width will result in an increase in the fluorescence excitation intensity. 

 

e Set the slit width of the emission monochromator. 

NOTE As a general rule, at a fixed excitation slit width, a two-fold increase in the 

emission slit width will result in a four-fold increase in the emission intensity. 

Accordingly, a two-fold decrease in the emission slit width will result in a four-

fold decrease in the emission intensity. 

 

f In the ‘Ave. (averaging) Time’ field, enter the required value. 
A good starting point is 0.1 seconds. 

4 Set up the display, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab. The ‘Options’ page will be displayed. 

b Enter the minimum and maximum ‘Y values’ to be displayed 
on the graph axis during the data collection. 

c Set the ‘Excitation filter’ for the concentration measurement. 
It is recommended that you set the filter to Auto (the default 
setting). This will automatically move the filter wheel to the 
appropriate position for the selected excitation wavelength. 

d Set the ‘Excitation filter’ and the ‘Emission filter’ for the 
concentration measurement. In order to minimize steps in 
the spectra, it is recommended that you set the filter to Open 
(the default setting). 

e Set the EHT or sample detector PMT. The setting you choose 
will depend upon your sample. For example, a ‘Low’ setting 
is recommended for highly-emitting samples, while a ‘High’ 
setting is recommended for low-emitting samples. 

5 Set up the Multicell Holder accessory 

Setup dialog box | Accessories page  

a Click the Accessories tab to display the ‘Accessories’ page. 
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b Select the Multicell Holder check box to enable the 
accessory. 

c Ensure that you have this accessory installed before starting 
the run. 

d On the ‘Cell Holder’ diagram, select the cells you require. 

e Select the Multi Zero check box to enable the ‘Multi Zero’ 
facility. 

f Make sure that no other accessories are selected on this page.  

6 Set up the calibration  

Setup dialog box | Standards page  

a Click the Standards tab to access the ‘Standards’ page where 
you can set up the standards and their parameters associated 
with the data collection. 

b Set the appropriate ‘Units’ for your standards for reporting 
purposes. 

c Select ‘Replicates’ or ‘Std Averaging’ if required, and enter 
the appropriate number. 

d In the ‘Standards’ field, enter the number of standards that 
you are using in your calibration. The table below this field 
will expand or contract to match your choice. 

e In the ‘Standards’ table, enter the concentration of each 
standard in the ‘Conc.’ column. 

f Select the type of curve fitting required for your calibration 
under ‘Fit Type’. 

g Enter the required R2 value or correlation coefficient in the 
‘Min R2’ field. The closer the number is to 1.000 the better the 
fit. Typically, 0.95 is used. 

7 Set up your samples  

Setup dialog box | Samples page  

a Click the Samples tab to display the ‘Samples’ page. This 
page enables you to enter a list of sample names that will be 
used during your analysis. 
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b Enter the number of samples that you are going to use in the 
‘No. of Samples’ field. The table below this field will expand 
or contract to match your choice. 

c In the ‘Sample names’ table, enter the name of each sample. 
You can enter up to 20 characters for each name. 

If you would like the samples to have the same name with a different 
numeric extension, enter the name in the first sample position and 
then click the ‘Increment’ button. 

8 Set up weight and volume correction  

a Select the Weight/Volume Corrections check box. 

b Enter the theoretical sample weight in the ‘Method Weight’ 
field. This is the weight of the sample specified in your 
method. (The Actual Weight is entered for each sample in the 
‘Sample Names’ list.) 

c Enter the units in the ‘Weight Units’ field. 

d Enter the theoretical sample volume in the ‘Method Volume’ 
field. This is the volume to which the method tells you to 
make the sample. (The Actual Volume is entered for each 
sample in the ‘Sample Names’ list.) 

e Enter the units in the ‘Volume Units’ field. 

f In the ‘Sample Names’ table, enter the ‘Actual Weight’ and 
‘Actual Volume’ for each sample. 

9 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method. 

b Enter your name in the ‘Name’ field. 

c Optional: Enter a comment relating to your experiment in the 
‘Comment’ field. 

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example select: 

 ‘Auto Print’ to automatically obtain a printout of your report. 

 ‘Parameters’ to include your experimental parameters in the 
report. 
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 ‘Graph’ to include a calibration graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as the Report area. However if „Auto Print‟ is not 

selected, the report will only be sent to the Report area and can be viewed by 

choosing „Report‟ from the „View‟ menu. 

 

10 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page. 

b Set the ‘Storage’ option to Off. The method (with calibration), 
collected data and report will not be automatically saved. 
However, you can manually save it all at the end of the 
collection. 

c Select the ‘Auto Convert’ option you require. If you select 
‘ASCII (csv)’ or ‘ASCII (csv) with log’, at the end of the data 
collection the system will automatically generate a report and 
store the data both in the Cary Eclipse format as well as 
ASCII XY pairs format. The data file will be saved in the 
current folder. 

11 Set up visual system monitoring  

Select the Status Display check box on any of the ‘Setup’ pages to 
display various information fields on your current reaction. 

12 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

13 Zero the instrument  

a From the Concentration application window, click the Zero 
button to zero the system. Alternatively, choose Zero from 
the Commands menu. The ‘Zero’ dialog box will be displayed. 

b Place a blank in the sample compartment and click OK. 
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14 Perform the calibration and measure the samples  

a Click the Start button or choose Start from the Commands 
menu. The ‘Standard/Sample Selection’ dialog box will be 
displayed. 

b Select the standards and samples to be used in the analysis. 
By default, all standards and samples are selected. 

c Click OK to close The ‘Standard/Sample Selection’ dialog 
box. 

d The ‘Cell Loading Guide’ dialog box will be displayed. Load 
your standards as indicated, then click OK to start reading 
the standards. If additional ‘Cell Loading Guide’ dialog boxes 
are displayed, continue to load your standards as indicated 
and click ‘OK’ to continue loading the standards. The Cary 
Eclipse will measure the standards and calculate the 
calibration curve. 

e A ‘Cell Loading Guide’ will be displayed for the samples. 
Load your samples as indicated and click OK. The Cary 
Eclipse will then measure the samples and calculate their 
concentration. 

NOTE If the set correlation coefficient (R2) value is not met, the Cary Eclipse will prompt 

you with „Min R2 test failed‟. When you click “OK‟, the Cary Eclipse will then 

prompt you with „There is no valid calibration. Proceed in Intensity (a.u.)?‟ If you 

click „Cancel‟, the Concentration run will finish. If you click „OK‟, the Cary Eclipse 

will measure the intensity of any presented samples, but will not generate a 

concentration. 

 

15 Save your data  

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this Concentration run. 

c Click Save. The collected data will be stored as a Batch file. 
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Manually measure concentrations  

You can use the Concentration application without calibrating the 
system to measure samples in Intensity mode. You can also use the 
duplicate/triplicate or replicate feature of the Concentration 
software to allow simple statistical calculations to be applied to your 
measurements. These measurements modes can be used in 
conjunction with the accessories. 

1 Start the Concentration application  

Click the Windows Start button, point to Programs, Cary Eclipse 
and then choose Concentration. The Concentration application will 
open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Concentration application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters 

Setup dialog box | Cary page  

a In the ‘Data mode’ field, set the ‘Mode’ to Fluorescence. 

b In the ‘Ex. Wavelength’ field, set the wavelength of the 
excitation monochromator, which is the wavelength value at 
which you want to excite your sample. 

c In the ‘Em. Wavelength’ field, set the wavelength of the 
emission monochromator, which is the wavelength value at 
which your sample emits. 

d Set the slit width of the excitation monochromator. 
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NOTE As a general rule, at a fixed emission slit width, increasing the excitation slit 

width will result in an increase in the fluorescence excitation intensity. 

 

e Set the slit width of the emission monochromator. 

NOTE As a general rule, at a fixed excitation slit width, a two-fold increase in the 

emission slit width will result in a four-fold increase in the emission intensity. 

Accordingly, a two-fold decrease in the emission slit width will result in a four-

fold decrease in the emission intensity. 

 

f In the ‘Ave. (averaging) Time’ field, enter the required value. 
A good starting point is 0.1 seconds. 

4 Set up the display, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab. The ‘Options’ page will be displayed. 

b Enter the minimum and maximum ‘Y values’ to be displayed 
on the graph axis during the data collection. 

c Set the ‘Excitation filter’ for the concentration measurement. 
It is recommended that you set the filter to Auto (the default 
setting). This will automatically move the filter wheel to the 
appropriate position for the selected excitation wavelength. 

d Set the ‘Excitation filter’ and the ‘Emission filter’ for the 
concentration measurement. In order to minimize steps in 
the spectra, it is recommended that you set the filter to Open 
(the default setting). 

e Set the EHT or sample detector PMT. The setting you choose 
will depend upon your sample. For example, a ‘Low’ setting 
is recommended for highly-emitting samples, while a ‘High’ 
setting is recommended for low-emitting samples. 
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5 Make sure that no accessories are selected 

Setup dialog box | Accessories page 

Click the Accessories tab and en sure that no accessories are 
selected. 

6 Set up the calibration  

Setup dialog box | Standards page 

a Click the Standards tab. The ‘Standards’ page will be 
displayed. 

b Set the ‘Standards’ field to ‘1’ (it is not possible to set this 
field to ‘0’). 

7 Set up your samples  

Setup dialog box | Samples page  

a Click the Samples tab to display the ‘Samples’ page. This 
page enables you to enter a list of sample names that will be 
used during your analysis. 

b Enter the number of samples that you are going to use in the 
‘No. of Samples’ field. The table below this field will expand 
or contract to match your choice. 

c In the ‘Sample names’ table, enter the name of each sample. 
You can enter up to 20 characters for each name. 

If you would like the samples to have the same name with a different 
numeric extension, enter the name in the first sample position and 
then click the ‘Increment’ button. 

8 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page.  

b Set the ‘Storage’ option to Off. The method (with calibration), 
collected data and report will not be automatically saved. 
However, you can manually save it all at the end of the 
collection. 
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c Select the ‘Auto Convert’ option you require. If you select 
‘ASCII (csv)’ or ‘ASCII (csv) with log’, at the end of the data 
collection the system will automatically generate a report and 
store the data both in the Cary Eclipse format as well as 
ASCII XY pairs format. The data file will be saved in the 
current folder. 

9 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method. 

b Enter your name in the ‘Name’ field. 

c Optional: Enter a comment relating to your experiment in the 
‘Comment’ field.  

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’.  For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report.  

 ‘Graph’ to include a calibration graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as the Report area. However if „Auto Print‟ is not 

selected, the report will only be sent to the Report area and can be viewed by 

choosing „Report‟ from the „View‟ menu. 

 

10 Set up visual system monitoring  

Select the Status Display check box on any of the ‘Setup’ pages to 
display various information fields on your current reaction. 

11 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 
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NOTE As a calibration is not to be performed it is recommended the display of the 

graphics area is turned off. To do this, clear the „Graphics‟ option in the „View‟ 

menu. At this stage, you should consider saving the method for future use by 

choosing „Save method as‟ from the „File‟ menu. 

 

12 Zero the instrument  

a From the Concentration application window, click the Zero 
button to zero the system. Alternatively, choose Zero from 
the Commands menu. The ‘Zero’ dialog box will be displayed.  

b Place a blank in the sample compartment and click OK. 

13 Measure sample intensity  

a Click the Start button or choose Start from the Commands 
menu. The ‘Standard/Sample Selection’ dialog box will 
appear. 

b In the ‘Selected for Analysis’ list, highlight the standard and 
click the < button to transfer it to the ‘Solutions Available’ 
list. The standard will not be included in the analysis. 

c Select the samples to be used in the analysis. By default, all 
samples are selected. 

d Click OK to close The ‘Standard/Sample Selection’ dialog 
box. As no standards have been selected the message ‘There 
is no valid calibration. Proceed in Intensity (a.u.)?’ will be 
displayed. 

e Click OK to continue.  

f The ‘Present Sample’ dialog box will be displayed to prompt 
you to place the appropriate sample in the sample 
compartment. 

NOTE If you are using an accessory, a dialog box specific to that accessory will appear 

in place of the „Present Sample‟ dialog box. 
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g Click OK to measure the sample and display the intensity. (If 
replicates have been nominated, the mean intensity is 
calculated after the final sample replicate is read.) 

h Repeat Steps f and g for the remaining samples. 

14 Save your data  

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this Concentration run. 

c Click Save. The collected data will be stored as a Batch file. 

Kinetics 

The following Kinetics procedures are described: 

 Performing a single-wavelength run 

 Performing a multi-wavelength, temperature-controlled run 

Perform a single-wavelength Kinetics run 

This procedure demonstrates how to perform a fluorescence single-
wavelength Kinetics run at ambient temperature. Follow the steps, 
adjusting them to meet the requirements of your particular data 
collection.  

1 Start the Kinetics application  

Click the Windows Start button, point to Programs, Cary Eclipse 
and then choose Kinetics. The Kinetics application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Kinetics application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 
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3 Set up instrument parameters 

Setup dialog box | Cary page  

a In the ‘Data mode’ field, set the ‘Mode’ to Fluorescence. 

b In the ‘Ex. Wavelength’ field, set the wavelength of the 
excitation monochromator to a wavelength at which the 
chromophore absorbs light. For example, if you were 
measuring quinine, this absorbs at 350 nanometers. 

c In the ‘Em. Wavelength’ field, set the wavelength of the 
emission monochromator. For quinine this would be 
approximately 450 nanometers. 

d Set the slit width of the excitation and emission 
monochromators to ‘5’. 

NOTE As a general rule, at a fixed emission slit width, increasing the excitation slit 

width will result in an increase in the fluorescence excitation intensity. You can 

therefore choose to increase the slit width if the resultant intensity is too low. 

However, it is recommended that you initially try to increase intensity by using 

the „PMT Detector Voltage‟ setting (on the „Options‟ page). 

 

4 Set up rate parameters  

a Under ‘Collect Timing’, select the Simple Collect option. This 
sets up a single rate for your reaction. 

b Enter a ‘Cycle time’ of ‘0’. The ‘Ave. time’ will therefore be 
used to determine the distance between points. 

TIP If you have a long, slow reaction, use the „Cycle time‟ to limit the number of data 

points that are collected. 

 

c Specify the duration of the Kinetics run by setting the ‘Stop 
time’ for the rate stage. You will need to have knowledge of 
your experiment to determine this value. 
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d In the ‘Ave. (averaging) Time’ field, enter the required value. 
If the sample you are measuring is highly fluorescent, 0.1 
seconds is a good starting point. If the sample fluoresces 
quickly, you may need to decrease the Ave. time to 0.0125 
seconds in order to ensure that you produce a data point 
each time the lamp is flashed. Note however that decreasing 
the Ave. time will increase the signal-to-noise ratio. 

5 Set up the display, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab. The ‘Options’ page will be displayed. 

b Under ‘Display Options’, select the way in which you want 
the data displayed as it is collected. For example, click the 
‘Overlay Data’ button to superimpose the collected data of 
each sample in the kinetics run in one graph box. 

c Enter the minimum and maximum ‘Y values’ to be displayed 
on the graph axis during the data collection. 

d Set the ‘Excitation filter’ and the ‘Emission filter’ for the 
concentration measurement to Auto. It is not necessary to 
set the Emission filter to the default setting of ‘Open’, as you 
are only looking at a single wavelength. 

e Set the ‘PMT Detector Voltage’ to Medium. To determine 
whether this setting is most suitable for obtaining the highest 
possible intensity, use the ‘Rapid Result’ option, accessible 
from the ‘Commands’ menu. 

6 Make sure that no accessories are selected 

Setup dialog box | Accessories page 

Click the Accessories tab and ensure that no accessories are 
selected. 

7 Set up rate calculation, rate order and other rate parameters  

Setup dialog box | Analyze page  

a Click the Analyze tab. The ‘Analyze’ page will be displayed. 

b Select the Auto Calculate check box to automatically 
perform a rate calculation on collected data at the end of 
each run. 
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c Select Simple Calculate to set up one rate calculation for the 
entire kinetics run. 

d Enter a ‘Start’ time of ‘0’ minutes and a ‘Stop’ time that is the 
same as the ‘Stop’ time entered on the ‘Cary’ page. 

8 The ‘Order’ you set will depend upon the reaction you are 
performing. Choose from ‘Zero’, ‘First’ or ‘Second’.  

9 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method. 

b Enter your name in the ‘Name’ field. 

c Optional: Enter a comment relating to your experiment in the 
‘Comment’ field.  

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report.  

 ‘Graph’ to include a calibration graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as the Report area. However if „Auto Print‟ is not 

selected, the report will only be sent to the Report area and can be viewed by 

choosing „Report‟ from the „View‟ menu. 

 

e Select the X-Y Pairs Table check box to view a list of abscissa 
values and their corresponding intensity values.  

10 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page.  
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b Set the ‘Storage’ option to Off. The method (with calibration), 
collected data and report will not be automatically saved. 
However, you can manually save it all at the end of the 
collection. 

c Select the ‘Auto Convert’ option you require. If you select 
‘ASCII (csv)’ or ‘ASCII (csv) with log’, at the end of the data 
collection the system will automatically generate a report and 
store the data both in the Cary Eclipse format as well as 
ASCII XY pairs format. The data file will be saved in the 
current folder. 

11 Set up e-mail options 

Refer to How to ‘e-mail your results’ on Page 121 for instructions on 
setting up the e-mail options. 

12 Set up visual system monitoring  

Select the Status Display check box on any of the ‘Setup’ pages to 
display various information fields on your current reaction. 

13 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

14 Zero the instrument  

a Place the blank solution in the sample compartment of the 
Cary Eclipse instrument. 

b Click the Zero button to zero the system. Alternatively, 
choose Zero from the Commands menu to perform a zero. 
When the result is zeroed, the word ‘Zeroed’ will appear in 
the Y display box in the top left corner of the Kinetics 
application window. 

15 Start the run  

a Click the Start button to commence a Kinetics data 
collection. Alternatively, choose Start from the Commands 
menu. Do not add your active reagent at this time. The 
‘Sample Name’ dialog box will be displayed. 

b Place the sample in the sample compartment and click OK. 
The ‘Sync Start’ dialog box will be displayed. 



How To 

Cary Eclipse Software Manual 67 

c Add your active reagent just before the countdown reaches 
0:00 or commence the data collection by clicking OK. 

16 Save your data  

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this kinetics run. 

c Click Save. The collected data will be stored as a Batch file. 

Perform a multi-wavelength, temperature-controlled Kinetics run 

This procedure demonstrates how to perform a multi-wavelength, 
temperature-controlled Kinetics run using the PCB 150 water bath. 
Follow the steps, adjusting them to meet the requirements of your 
particular data collection.  

1 Start the Kinetics application  

Click the Windows Start button, point to Programs, Cary Eclipse 
and then choose Kinetics. The Kinetics application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Kinetics application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters  

Setup dialog box | Cary page  

a In the ‘Data mode’ field, set the ‘Mode’ to Fluorescence. 

b Under ‘Wavelength setup’, select Multiwavelength. The 
‘Multiwavelength’ table will be displayed. Enter the following 
parameters in the ‘Multiwavelength’ table. For the purpose of 
this example, FURA-2 will be used. 
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Name Ex. wavelength (nm) Em. wavelength (nm) 

Wavelength 1 340 510 

Wavelength 2 380 510 

 

c Set the slit width of the excitation and emission 
monochromators to ‘5’. 

NOTE As a general rule, at a fixed emission slit width, increasing the excitation slit 

width will result in an increase in the fluorescence excitation intensity. You can 

therefore choose to increase the slit width if the resultant intensity is too low. 

However it is recommended that you initially try to increase intensity by using 

the „PMT Detector Voltage‟ setting (on the „Options‟ page). 

 

4 Set up rate parameters  

a Under ‘Collect Timing’, select the Advanced Collect option. 
This enables you to set up different data collection 
procedures for the multiple rates in your reaction. 

NOTE The „Advanced Collect‟ facility enables you to collect data more frequently during 

the crucial stages of your reaction and to collect data less frequently where you 

know there will not be much activity. 

 

b Set the value in the ‘Number of Stages’ field to ‘3’. The table 
below will expand to three rows. 

c Set the ‘Ave. time’ to 0.0125 seconds. 

d Enter the following parameters in the ‘Stages’ table: 

 
 

Stage Cycle (min.) Stop (min.) 

1 0.0000 20.0000 

2 1.0000 60.0000 

3 5.0000 100.0000 
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Therefore, from 1 to 20 minutes, a cycle will be performed every 
0.0125 second. (When the ‘Cycle time’ is set to ‘0’, the ‘Ave. time’ is 
used to determine the distance between points.) From 21 to 60 
minutes, a cycle will be performed every 1.0000 minute and from 61 
to 100 minutes, a cycle will be performed every 5.0000 minutes. 

5 Set up the display, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab. The ‘Options’ page will be displayed. 

b Enter the minimum and maximum ‘Y values’ to be displayed 
on the graph axis during the data collection. 

c Set the ‘Excitation filter’ for the concentration measurement. 
It is recommended that you set the filter to Auto (the default 
setting). This will automatically move the filter wheel to the 
appropriate position for the selected excitation wavelength. 

d Set the ‘Excitation filter’ and the ‘Emission filter’ for the 
concentration measurement. In order to minimize steps in 
the spectra, it is recommended that you set the filter to Open 
(the default setting). 

e Set the ‘PMT Detector Voltage’. The setting you choose will 
depend upon your sample. For example, a ‘Low’ setting is 
recommended for highly-emitting samples, while a ‘High’ 
setting is recommended for low-emitting samples. 

6 Ensure that the Multicell Holder accessory is not selected 

Setup dialog box | Accessories page 

Click the Accessories tab to display the ‘Accessories’ page. On the 
‘Multicell/Temperature’ page, ensure that the ‘Multicell Holder’ 
accessory is not selected. 

7 Set up accessories for reaction temperature control and 
temperature display 

a Select the Temperature control check box to enable the 
‘Temperature’ group. 

b Click the down arrow adjacent to the ‘Device’ field and select 
the PCB 150 water bath accessory. 

c Set the ‘Temperature’ to 37 °C.  
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d Set the appropriate communications port from the ‘Port’ 
drop-down list. 

e Set the ‘Monitor’ to PCB 150. 

f Under ‘Temperature Display’, select Probe 1 to view the 
temperature of one temperature probe in the ‘Status Display’ 
window. 

8 Set up rate calculation, rate order and other rate parameters  

Setup dialog box | Analyze page  

a Click the Analyze tab. The ‘Analyze’ page will be displayed.  

b Select the Auto Calculate check box so that a rate calculation 
will be automatically performed on collected data at the end 
of each run. 

c Select Advanced Calculate to set up multiple rate 
calculations for the kinetics run. If you select ‘Advanced 
Calculate’, the Cary Eclipse system will also automatically 
calculate the values: ‘A0’, ‘AInf’ and ‘Rate’ when the ‘Start’ 
button is clicked. 

d In the ‘Number of stages’ field, enter a value of ‘3’. The 
‘Stages’ table will be expanded to three rows. 

e Enter the following parameters in the ‘Stages’ table: 

 
  

Stage Cycle (min.) Stop (min.) Order 

1 0.0000 20.0000 Depends on reaction 

2 1.0000 60.0000 Depends on reaction 

3 5.0000 100.0000 Depends on reaction 

 

9 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method. 

b Enter your name in the ‘Name’ field. 

c Optional: Enter a comment relating to your experiment in the 
‘Comment’ field.  
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d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report. 

 ‘Graph’ to include a calibration graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as the Report area. However if „Auto Print‟ is not 

selected, the report will only be sent to the Report area and can be viewed by 

choosing „Report‟ from the „View‟ menu. 

 

e Select the X-Y Pairs Table check box to view a list of abscissa 
values and their corresponding intensity values.  

10 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page.  

b Set the ‘Storage’ option to On; prompt at start. You will be 
prompted to save your method (with calibration), collected 
data and report when you commence the run. 

c Select the ‘Auto Convert’ option you require. If you select 
‘ASCII (csv)’ or ‘ASCII (csv) with log’, at the end of the data 
collection the system will automatically generate a report and 
store the data both in the Cary Eclipse format as well as 
ASCII XY pairs format. The data file will be saved in the 
current folder. 

11 Set up e-mail options 

Refer to How to ‘e-mail your results’ on Page 121 for instructions on 
setting up the e-mail options. 

12 Set up visual system monitoring  

Select the Status Display check box on any of the ‘Setup’ pages to 
display various information fields on your current reaction. 
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13 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

14 Zero the instrument  

a Place the blank solution in the sample compartment of the 
Cary Eclipse instrument. 

b Click the Zero button to zero the system. Alternatively, 
choose Zero from the Commands menu to perform a zero. 
When the result is zeroed, the word ‘Zeroed’ will appear in 
the Y display box in the top left corner of the Kinetics 
application window. 

15 Start the run  

a Click the Start button to commence a Kinetics data 
collection. Alternatively, choose Start from the Commands 
menu. Do not add your active reagent at this time. The 
system will display the ‘Save As’ dialog box.  

b Enter a ‘File name’ for this kinetics run and click Save. The 
system will display the ‘Sample Name’ dialog box.  

c Place the sample solution in the correct cell position and 
click OK. The ‘Sync Start’ dialog box will be displayed. 

d Add your active reagent just before the countdown reaches 
0:00 or commence the data collection by clicking OK. 
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Perform a temperature-controlled Lifetimes run 

This procedure demonstrates how to perform a single cell, multi-rate 
Lifetimes run at 37 °C using the single cell Peltier accessory. Follow 
the steps, adjusting them to meet the requirements of your particular 
data collection.  

1 Start the Lifetimes application  

Click the Windows Start button, point to Programs, Cary Eclipse 
and then choose Lifetimes. The Lifetimes application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Lifetimes application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Ensure that the Multicell Holder accessory is not selected 

Setup dialog box | Accessories page 

Click the Accessories tab to display the ‘Accessories’ page. On the 
‘Multicell/Temperature’ tabbed page, ensure that the ‘Multicell 
Holder’ accessory is not selected. 

4 Set up accessories for reaction temperature control and 
temperature display 

a Select the Temperature control check box to enable the 
‘Temperature’ group. 

b Click the down arrow adjacent to the ‘Device’ field and select 
the Single Cell Peltier accessory. 

c Set the ‘Temperature’ to 37 °C.  

d Under ‘Temperature Display’, select Probe 1 to view the 
temperature of one temperature probe in the ‘Status Display’ 
window. 
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5 Set up instrument parameters  

Setup dialog box | Cary page  

a Enter the ‘Delay Time’, which is the time that elapses 
between the last flash and the beginning of data collection. 
Setting a delay time ensures that there is no lamp effects in 
the phosphorescence decay curve. 

b Enter, in milliseconds, the ‘Gate Time’ for your sample. The 
‘Gate Time’ is the overall reading time of the emission signal. 

c Enter the ‘No. of Flashes’, which is how many times the lamp 
flashes consecutively before the delay time is counted. 

d In the ‘Ex. Wavelength’ field, set the wavelength of the 
excitation monochromator, which is the wavelength value at 
which you want to excite your sample. 

e In the ‘Em. Wavelength’ field, set the wavelength of the 
emission monochromator, which is the wavelength value at 
which your sample emits. 

f Set the slit width of the excitation monochromator. 

NOTE As a general rule, at a fixed emission slit width, increasing the excitation slit 

width will result in an increase in the fluorescence excitation intensity 

 

g Set the slit width of the emission monochromator. 

NOTE As a general rule, at a fixed excitation slit width, a two-fold increase in the 

emission slit width will result in a four-fold increase in the emission intensity. 

Accordingly, a two-fold decrease in the emission slit width will result in a four-

fold decrease in the emission intensity. 

 

6 Set up rate parameters  

a Enter the ‘Total Decay Time’. You should enter a time that 
will allow for the phosphorescence signal to decay to 
approximately zero. The lamp will not flash until the total 
decay time has elapsed. 
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b Enter the ‘No. of Cycles’ (or decay curves) over which the run 
will be collected. This number will be used to average the 
data. Entering a number of cycles value enables you to obtain 
better signal to noise ratios as multiple traces can be 
averaged. 

7 Set up the display, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab. The ‘Options’ page will be displayed. 

b Enter the minimum and maximum ‘Y values’ to be displayed 
on the graph axis during the data collection. 

c Set the ‘Excitation filter’ for the concentration measurement. 
It is recommended that you set the filter to Auto (the default 
setting). This will automatically move the filter wheel to the 
appropriate position for the selected excitation wavelength. 

d Set the ‘Excitation filter’ and the ‘Emission filter’ for the 
concentration measurement. In order to minimize steps in 
the spectra, it is recommended that you set the filter to Open 
(the default setting). 

e Set the ‘PMT Detector Voltage’. The setting you choose will 
depend upon your sample. For example, a ‘Low’ setting is 
recommended for highly-emitting samples, while a ‘High’ 
setting is recommended for low-emitting samples. 

8 Set up rate calculation, rate order and other rate parameters  

Setup dialog box | Analyze page  

a Click the Analyze tab. The ‘Analyze’ page will be displayed.  

b Select the Auto Calculate check box to automatically 
perform a rate calculation on collected data at the end of 
each run.  

c In the ‘Decay Time’ table, enter the calculation ‘Start’ and 
‘Stop’ times (in minutes or seconds) for a rate or lifetime 
calculation analysis and select the ‘Function Type’.  

d You can select the ‘Manual Guess’ check box and manually 
enter the parameters: ‘Intensity’ (0), ‘Intensity’ () and 
‘Rate’. It is presumed that you have a reasonable idea of the 
values for these fit parameters, as they will be used as a first 
guess in the fitting procedure. 
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NOTE If you do not choose „Manual Guess‟, the Cary Eclipse system will automatically 

calculate the values for Intensity(0), Intensity() and Rate when you click „OK‟ 

to exit the „Setup‟ dialog box. 

 

e Set the ‘Plot type’ to Fit to automatically overlay the 
calculated lines of best fit onto the plotted data. 

9 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method. 

b Enter your name in the ‘Name’ field.  

c Optional: Enter a comment relating to your experiment in the 
‘Comment’ field.  

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report.  

 ‘Graph’ to include a calibration graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as the Report area. However if „Auto Print‟ is not 

selected, the report will only be sent to the Report area and can be viewed by 

choosing „Report‟ from the „View‟ menu. 

 

e Select the X-Y Pairs Table check box to view a list of abscissa 
values and their corresponding intensity values.  

10 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page.  
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b Set the ‘Storage’ option to On; prompt at start. You will be 
prompted to save your method (with calibration), collected 
data and report when you commence the run. 

c Select the ‘Auto Convert’ option you require. If you select 
‘ASCII (csv)’ or ‘ASCII (csv) with log’, at the end of the data 
collection the system will automatically generate a report and 
store the data both in the Cary Eclipse format as well as 
ASCII XY pairs format. The data file will be saved in the 
current folder. 

11 Set up visual system monitoring  

Select the Status Display check box on any of the ‘Setup’ pages to 
display various information fields on your current reaction. 

12 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

13 Zero the instrument  

a Click the Zero button to zero the system. Alternatively, 
choose Zero from the Commands menu to perform a zero. 
The ‘Cell Loading Guide’ dialog box will be displayed. 

b Place the blank solution in the sample compartment and click 
OK. The system will perform an instrument zero on the blank 
solution.  

14 Start the run  

a Click the Start button to commence a Lifetimes data 
collection. Alternatively, choose Start from the Commands 
menu. Do not add your active reagent at this time. The 
system will display the ‘Save As’ dialog box. 

b Enter a ‘File name’ for the lifetimes run and click Save. The 
system will display the ‘Cell Loading Guide’ dialog box. 

c Place the sample solution in the correct cell position and 
click OK. The ‘Sync Start’ dialog box will be displayed. 

d Add your active reagent just before the countdown reaches 
0:00 or commence the data collection by clicking OK. 



How To 

78 Cary Eclipse Software Manual 

Scan 

The following Scan procedures are described: 

 Performing a fluorescence scan 

 Performing a fluorescence scan in Cycle mode 

 Performing a fluorescence scan in Signal-To-Noise mode 

 Performing a bio-/chemi-luminescence scan 

 Performing a bio-/chemi-luminescence scan in Cycle mode 

 Performing a phosphorescence scan 

 Performing a phosphorescence scan in Cycle mode 

 Performing a phosphorescence scan in Signal-To-Noise mode 

Perform a fluorescence scan 

This procedure demonstrates how to perform a wavelength scan in 
Fluorescence mode. 

1 Start the Scan application  

Click the Windows Start button, point to Programs, Cary Eclipse 
and then choose Scan. The Scan application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Scan application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters  

Setup dialog box | Cary page  

a Set the ‘Data Mode’ to Fluorescence. 
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b Set the ‘Scan setup mode’ to Emission. During the emission 
scan, the excitation monochromator is set to a fixed 
wavelength and the emission monochromator is scanned 
over a wavelength range. 

c Set the ‘X mode’ to Wavelength (nm). 

d Enter an ‘Excitation’ value that is within the region where 
the fluorescent molecule to be scanned will absorb light. For 
purposes of this procedure, anthracene will be used as an 
example and therefore a value of 360 nanometers should be 
set. 

e Enter an ‘Excitation slit’ value of 5 nanometers and an 
‘Emission slit’ value of 5 nanometers. Slits determine the 
resolution of the spectrum and therefore are used in 
conjunction with the ‘PMT Detector Voltage’ (set on the 
‘Options’ page) to determine concentration. If a compound is 
highly fluorescent and has reasonable signal intensity (as is 
the case for anthracene), the slits can be set quite narrow. 

f Enter a ‘Start’ value of 370 nanometers and enter a ‘Stop’ 
value of 520 nanometers. The ‘Start’ value should be set to 
the ‘Excitation’ value plus the sum of the slits. In this 
example, as the ‘Excitation’ value is 360 nanometers, and the 
sum of the slits is 10 nanometers, the ‘Start’ value is set to 
370 nanometers. Typically the ‘Stop’ value should be set to 
150 to 200 nanometers greater than the ‘Start’ value. 

g If selected, clear the ‘3-D Mode’ check box. 

h Set the ‘Scan Control’ to Medium.  

4 Set up visual system monitoring  

Select the Status Display check box so that you can view various 
instrument parameters during the scan. 

5 Set up the display, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab to display the ‘Options’ page. 

b Under ‘Display Options’, select the Overlay traces check box 
to overlay the results of the traces on one graph. 

c If selected, clear the ‘CAT or S/N Mode’, ‘Cycle Mode’ and 
‘Smoothing’ check boxes. 
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d Set the ‘Excitation filter’ to Auto. This will automatically 
move the filter wheel to the appropriate position for the 
selected excitation wavelength. 

e Set the ‘Emission filter’ to Open in order to minimize steps in 
the spectra.  

f Set the ‘PMT Detector Voltage’ to Medium. This setting can 
later be adjusted if results are over-range. If the signal is too 
high, decrease the ‘PMT Detector Voltage’. If the signal is too 
low, increase the ‘PMT Detector Voltage’.  

6 Make sure that no accessories are selected  

Setup dialog box | Accessories page 

Ensure that no options are selected on any of the ‘Accessories’ page 
tabs. 

7 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method.  

b Enter your name in the ‘Name’ field.  

c If required, enter any comments relating to your experiment 
in the ‘Comment’ field.  

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report.  

 ‘Graph’ to include a graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as displaying it in the Report area. However if „Auto 

Print‟ is not selected, the report will be displayed in the Report area only. The 

Report area can be viewed by choosing „Report‟ from the „View‟ menu. 
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e Set up the ‘Peaks’ reporting options.  

f Select Maximum peaks to report the peak with the largest 
peak threshold that exceeds the peak ‘Threshold’ value. 

g Select All peaks to report all peaks meeting the ‘Peak type’ 
criterion and exceeding the ‘Threshold’ value. 

h Select the Peak type and specify the peak ‘Threshold’. 

i If required, select the ‘X-Y Pairs table’ check box. You can use 
the ‘Actual Data Interval’ by which the data was collected or 
you can make the Cary Eclipse ‘Interpolate’ the points to a 
new interval.  

8 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page. Use 
this page to set up whether the collected data is to be saved, 
and if so, when the Cary Eclipse should store the 
information. 

b Select the ‘Storage’ option of On; Prompt at end. 

c Select the ‘Auto Convert’ option you require. If you select 
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at 
the end of the data collection the system will automatically 
generate a report and store the data both in the Cary Eclipse 
format as well as ASCII XY pairs format in the current folder. 

9 Set up e-mail options  

Refer to How to ‘e-mail your results’ on Page 121 for instructions on 
setting up the e-mail options. 

10 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

11 Zero the instrument  

a Place the blank solution in the sample compartment of the 
Cary Eclipse instrument. 
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b Click the Zero button to zero the system. Alternatively, 
choose Zero from the Commands menu to perform a zero. 
When the result is zeroed, the word ‘Zeroed’ will appear in 
the Y display box in the top left corner of the Scan 
application window. 

12 Start the run  

a Click the Start button to commence a Scan data collection. 
Alternatively, choose Start from the Commands menu. The 
‘Sample Name’ dialog box will be displayed. 

b Place the sample in the sample compartment of the Cary 
Eclipse instrument. 

c In the ‘Sample Name’ dialog box, enter the appropriate name 
for you sample and click OK. The scan will commence and 
the trace will appear in the Graphics area. 

13 Save your data  

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this scan run. 

c Click Save. The collected data will be stored as a Batch file. 

Perform a fluorescence scan in Cycle mode 

This procedure demonstrates how to perform a fluorescence 
wavelength scan in Cycle mode. 

1 Start the Scan application  

Click the Windows Start button, point to Programs, Cary Eclipse 
and then choose Scan. The Scan application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Scan application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 
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3 Set up instrument parameters  

Setup dialog box | Cary page  

a Set the ‘Data mode’ to Fluorescence. 

b Set the ‘Scan setup mode’ to Emission. During the emission 
scan, the excitation monochromator is set to a fixed 
wavelength and the emission monochromator is scanned 
over a wavelength range. 

c Set the ‘X mode’ to Wavelength (nm). 

d Enter an ‘Excitation’ value that is within the region where 
the fluorescent molecule to be scanned will absorb light. For 
purposes of this example, anthracene will be used as an 
example and therefore a value of 360 nanometers should be 
set. 

e Enter an ‘Excitation slit’ value of 5 nanometers and an 
‘Emission slit’ value of 5 nanometers. Slits determine the 
resolution of the spectrum and therefore are used in 
conjunction with the ‘PMT Detector Voltage’ (set on the 
‘Options’ page) to determine concentration. If a compound is 
highly fluorescent and has reasonable signal intensity (as is 
the case for anthracene) the slits can be set quite narrow.  

f Enter a ‘Start’ value of 370 nanometers and enter a ‘Stop’ 
value of 520 nanometers. The ‘Start’ value should be set to 
the ‘Excitation’ value plus the sum of the slits. In this 
example, as the ‘Excitation’ value is 360 nanometers, and the 
sum of the slits is 10 nanometers, The ‘Start’ value is set to 
370 nanometers. Typically the ‘Stop’ value should be set to 
150 to 200 nanometers greater than the ‘Start’ value. 

g If selected, clear the ‘3-D Mode’ check box.  

4 Set up visual system monitoring  

Select the Status Display check box so that you can view various 
instrument parameters during the scan. 

5 Set up the cycle mode, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab to display the ‘Options’ page. 
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b Select the Cycle mode option. This option enables you to 
collect scans as a function of time to determine whether the 
spectrum is changing. (By contrast, the Kinetics application 
enables you to determine whether a single wavelength is 
changing over time.)  
If this option is not available, clear the ‘CAT or S/N mode’ 
check box. 

c Enter a ‘No. of scans’ value of ‘15’ to set the number of scans 
to be performed per cell or well. 

d Enter a ‘Time’ value of ‘1.0000’ to set the interval between 
each successive scan. If the time entered is less than the time 
required to complete a scan, the scans are performed 
continuously with no delay. 

e Set the ‘Excitation filter’ to Auto and the ‘Emission filter’ to 
Open. 

f Set the ‘PMT Detector Voltage’ to Medium. This setting can 
later be adjusted if results are over-range. If the signal is too 
high, decrease the ‘PMT Detector Voltage’. If the signal is too 
low, increase the ‘PMT Detector Voltage’.  

6 Make sure that no accessories are selected  

Setup dialog box | Accessories page 

Make sure that no options are selected on any of the ‘Accessories’ 
page tabs. 

7 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method.  

b Enter your name in the ‘Name’ field.  

c If required, enter any comments relating to your experiment 
in the ‘Comment’ field.  

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  
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 ‘Parameters’ to include your experimental parameters in the 
report.  

 ‘Graph’ to include a graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as displaying it in the Report area. However if „Auto 

Print‟ is not selected, the report will be displayed in the Report area only. The 

Report area can be viewed by choosing „Report‟ from the „View‟ menu. 

 

e Set up the ‘Peaks’ reporting options.  

f Select Maximum peaks to report the peak with the largest 
peak threshold that exceeds the peak ‘Threshold’ value. 

g Select All peaks to report all peaks meeting the ‘Peak type’ 
criterion and exceeding the ‘Threshold’ value. 

h Select the Peak type and specify the peak ‘Threshold’. 

i If required, select the ‘X-Y Pairs table’ check box. You can use 
the ‘Actual Data Interval’ by which the data was collected or 
you can make the Cary Eclipse ‘Interpolate’ the points to a 
new interval.  

8 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page. Use 
this page to set up whether the collected data is to be saved, 
and if so, when the Cary Eclipse should store the 
information. 

b Select the ‘Storage’ option of On; prompt at end. 

c Select the ‘Auto Convert’ option you require. If you select 
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at 
the end of the data collection the system will automatically 
generate a report and store the data both in the Cary Eclipse 
format as well as ASCII XY pairs format in the current folder. 

9 Set up e-mail options   

Refer to How to ‘e-mail your results’ on Page 121 for instructions on 
setting up the e-mail options. 
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10 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

11 Zero the instrument  

a Place the blank solution in the sample compartment of the 
Cary Eclipse instrument. 

b Click the Zero button to zero the system. Alternatively, 
choose Zero from the Commands menu to perform a zero. 
When the result is zeroed, the word ‘Zeroed’ will appear in 
the Y display box in the top left corner of the Scan 
application window. 

12 Start the run  

a Click the Start button to commence a Scan data collection. 
Alternatively, choose Start from the Commands menu. The 
‘Sample Name’ dialog box will be displayed. 

b In the ‘Sample Name’ dialog box, enter the appropriate name 
for you sample and click OK. The ‘Sync Start’ dialog box will 
be displayed. 

c The ‘Sync Start’ dialog box displays a two minute countdown 
in seconds. If you want to start your data collection before 
the two minute countdown ends, add your active reagent and 
click ‘OK’. Alternatively, you can add your active reagent and 
wait for the countdown to end. The data collection will 
automatically start. 

13 Save your data  

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this scan run. 

c Click Save. The collected data will be stored as a Batch file. 
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Perform a fluorescence scan in Signal-To-Noise mode 

This procedure demonstrates how to perform a fluorescence 
wavelength scan in Signal-To-Noise mode. 

1 Start the Scan application  

Click the Windows Start button, point to Programs, Cary Eclipse 
and then choose Scan. The Scan application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Scan application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters  

Setup dialog box | Cary page  

a Set the ‘Data mode’ to Fluorescence. 

b Set the ‘Scan setup mode’ to Emission. During the emission 
scan, the excitation monochromator is set to a fixed 
wavelength and the emission monochromator is scanned 
over a wavelength range. 

c Set the ‘X mode’ to Wavelength (nm).  

d Enter an ‘Excitation’ value that is within the region where 
the fluorescent molecule to be scanned will absorb light. For 
purposes of this example, anthracene will be used as an 
example and therefore a value of 360 nanometers should be 
set. 
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e Enter an ‘Excitation slit’ value of 5 nanometers and an 
‘Emission slit’ value of 5 nanometers. Slits determine the 
resolution of the spectrum and therefore are used in 
conjunction with the ‘PMT Detector Voltage’ (set on the 
‘Options’ page) to determine concentration. If a compound is 
highly fluorescent and has reasonable signal intensity (as is 
the case for anthracene) the slits can be set quite narrow.  

f Enter a ‘Start’ value of 370 nanometers and enter a ‘Stop’ 
value of 520 nanometers. The ‘Start’ value should be set to 
the ‘Excitation’ value plus the sum of the slits. In this 
example, as the ‘Excitation’ value is 360 nanometers, and the 
sum of the slits is 10 nanometers, The ‘Start’ value is set to 
370 nanometers. Typically the ‘Stop’ value should be set to 
150 to 200 nanometers greater than the ‘Start’ value.  

g If selected, clear the ‘3-D Mode’ check box.  

4 Set up visual system monitoring  

Select the Status Display check box so that you can view various 
instrument parameters during the scan. 

5 Set up the display, signal-to-noise, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab to display the ‘Options’ page. 

b Under ‘Display Options’, select the Overlay traces check box 
to overlay the results of the traces on one graph. 

c Select the CAT or S/N mode option. If this option is not 
available, clear the ‘Cycle mode’ and/or ‘Smoothing’ check 
boxes. 

d Set the ‘Mode’ to S/N mode. You will be informed that the 
‘Scan control’ on the ‘Cary’ page will be set to ‘Manual’. Click 
OK to continue. 

e Set the ‘S/N’ value to ‘600’ and the ‘Time out (s)’ value to 
‘1.000’. The Cary Eclipse instrument will control the 
‘Averaging Time’ by waiting at each data point and averaging 
the signal until the value set in the ‘S/N’ field is obtained. 
This parameter is useful if you have areas of low 
transmission in your scan and wish to have the same level of 
‘noise’ across the whole scan. 
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f Set the ‘Excitation filter’ to Auto and the ‘Emission filter’ to 
Open. 

g Set the ‘PMT Detector Voltage’ to Medium. This setting can 
later be adjusted if results are over-range. If the signal is too 
high, decrease the ‘PMT Detector Voltage’. If the signal is too 
low, increase the ‘PMT Detector Voltage’.  

6 Make sure that no accessories are selected  

Setup dialog box | Accessories page 

Make sure that no options are selected on any of the ‘Accessories’ 
page tabs. 

7 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method.  

b Enter your name in the ‘Name’ field.  

c If required, enter any comments relating to your experiment 
in the ‘Comment’ field.  

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report. 

 ‘Graph’ to include a graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as displaying it in the Report area. However if „Auto 

Print‟ is not selected, the report will be displayed in the Report area only. The 

Report area can be viewed by choosing „Report‟ from the „View‟ menu. 

 

e Set up the ‘Peaks’ reporting options.  

f Select Maximum peaks to report the peak with the largest 
peak threshold that exceeds the peak ‘Threshold’ value. 
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g Select All peaks to report all peaks meeting the ‘Peak type’ 
criterion and exceeding the ‘Threshold’ value. 

h Select the Peak type and specify the peak ‘Threshold’. 

i If required, select the ‘X-Y Pairs table’ check box. You can use 
the ‘Actual Data Interval’ by which the data was collected or 
you can make the Cary Eclipse ‘Interpolate’ the points to a 
new interval.  

8 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page. Use 
this page to set up whether the collected data is to be saved, 
and if so, when the Cary Eclipse should store the 
information. 

b Select the ‘Storage’ option of On; Prompt at end. 

c Select the ‘Auto Convert’ option you require. If you select 
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at 
the end of the data collection the system will automatically 
generate a report and store the data both in the Cary Eclipse 
format as well as ASCII XY pairs format in the current folder. 

9 Set up e-mail options  

Refer to How to ‘e-mail your results’ on Page 121 for instructions on 
setting up the e-mail options. 

10 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

11 Zero the instrument  

a Place the blank solution in the sample compartment of the 
Cary Eclipse instrument. 

b Click the Zero button to zero the system. Alternatively, 
choose Zero from the Commands menu to perform a zero. 
When the result is zeroed, the word ‘Zeroed’ will appear in 
the Y display box in the top left corner of the Scan 
application window. 
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12 Start the run  

a Click the Start button to commence a Scan data collection. 
Alternatively, choose Start from the Commands menu. The 
‘Sample Name’ dialog box will be displayed. 

b In the ‘Sample Name’ dialog box, enter the appropriate name 
for you sample and click OK. The scan will commence and 
the trace will appear in the Graphics area. 

13 Save your data  

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this scan run. 

c Click Save. The collected data will be stored as a Batch file. 

Perform a bio-/chemi-luminescence scan 

This procedure demonstrates how to perform a wavelength scan in 
bio-/chemi-luminescence mode. 

1 Start the Scan application  

Click the Windows Start button, point to Programs, Cary Eclipse 
and then choose Scan. The Scan application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Scan application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters 

Setup dialog box | Cary page  

a Set the ‘Data Mode’ to Bio-/Chemi-luminescence.  



How To 

92 Cary Eclipse Software Manual 

b Click the Options button to display the ‘Bio-/Chemi-
luminescence Options’ dialog box. Enter the ‘Gate Time’ as 
200 milliseconds. The ‘Gate Time’ is the overall reading time 
of the emission signal and is typically set to between 100 and 
500 milliseconds. 

c Click OK to close the ‘Bio-/Chemi-luminescence Options’ 
dialog box and return to the ‘Cary’ page.  

NOTE Under „Scan setup‟, the „Excitation‟ and „Synchronous‟ options are unavailable 

as the lamp does not flash for a Bio-/Chemi-luminescence scan. Therefore, it is 

set to „Emission‟ mode. 

 

d Set the ‘X mode’ to Wavelength (nm).  

e Enter a ‘Start’ value of 300 nanometers and enter a ‘Stop’ 
value of 750 nanometers. The ‘Start’ value should be set to 
the ‘Excitation’ value plus the sum of the slits. 

f Enter an ‘Emission slit’ value of 10 nanometers. Slits 
determine the resolution of the spectrum and therefore are 
used in conjunction with the ‘PMT Detector Voltage’ (set on 
the ‘Options’ page) to determine concentration. 

g Under ‘Scan control’, set the ‘Averaging time’ to 0.20000 
seconds and the ‘Data interval’ to 1.0000 nanometer.  

4 Set up visual system monitoring  

Select the Status Display check box so that you can view various 
instrument parameters during the scan. 

5 Set up the display, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab to display the ‘Options’ page. 

b Under ‘Display Options’, select the Overlay traces check box 
to overlay the results of the traces on one graph. 

c If selected, clear the ‘CAT or S/N Mode’, ‘Cycle Mode’ and 
‘Smoothing’ check boxes. 

d Set the ‘Emission filter’ to Open in order to minimize steps in 
the spectra.  
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e Set the ‘PMT Detector Voltage’ to High. A ‘High’ setting is 
recommended as luminescence spectra are generally quite 
weak and therefore require a sensitive system to detect them. 
This setting can later be adjusted if results are over-range. If 
the signal is too high, decrease the ‘PMT Detector Voltage’.  

6 Make sure that no accessories are selected  

Setup dialog box | Accessories page 

Make sure that no options are selected on any of the ‘Accessories’ 
page tabs. 

7 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method. 

b Enter your name in the ‘Name’ field. I 

c f required, enter any comments relating to your experiment 
in the ‘Comment’ field.  

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report.  

 ‘Graph’ to include a graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as displaying it in the Report area. However if „Auto 

Print‟ is not selected, the report will be displayed in the Report area only. The 

Report area can be viewed by choosing „Report‟ from the „View‟ menu. 

 

e Set up the ‘Peaks’ reporting options.  

f Select Maximum peaks to report the peak with the largest 
peak threshold that exceeds the peak ‘Threshold’ value. 
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g Select All peaks to report all peaks meeting the ‘Peak type’ 
criterion and exceeding the ‘Threshold’ value. 

h Select the Peak type and specify the peak ‘Threshold’. 

i If required, select the ‘X-Y Pairs table’ check box. You can use 
the ‘Actual Data Interval’ by which the data was collected or 
you can make the Cary Eclipse ‘Interpolate’ the points to a 
new interval.  

8 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page. Use 
this page to set up whether the collected data is to be saved, 
and if so, when the Cary Eclipse should store the 
information. 

b Select the ‘Storage’ option of On; Prompt at end. 

c Select the Autoconvert option you require. If you select 
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at 
the end of the data collection the system will automatically 
generate a report and store the data both in the Cary Eclipse 
format as well as ASCII XY pairs format in the current folder. 

9 Set up e-mail options  

Refer to How to ‘e-mail your results’ on Page 121 for instructions on 
setting up the e-mail options. 

10 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

11 Zero the instrument  

a Place the blank solution in the sample compartment of the 
Cary Eclipse instrument. 

b Click the Zero button to zero the system. Alternatively, 
choose Zero from the Commands menu to perform a zero. 
When the result is zeroed, the word ‘Zeroed’ will appear in 
the Y display box in the top left corner of the Scan 
application window. 
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12 Start the run  

a Click the Start button to commence a Scan data collection. 
Alternatively, choose Start from the Commands menu. The 
‘Sample Name’ dialog box will be displayed. 

b In the ‘Sample Name’ dialog box, enter the appropriate name 
for you sample and click OK. The Scan run will commence 
and the corrected trace will appear in the Graphics area. 

13 Save your data  

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this scan run. 

c Click Save. The collected data will be stored as a Batch file. 

Perform a bio-/chemi-luminescence scan in Signal-To-Noise mode 

This procedure demonstrates how to perform a bio-/chemi-
luminescence wavelength scan in Signal-To-Noise mode. 

1 Start the Scan application  

Click the Windows Start button, point to Programs, Cary Eclipse 
and then choose Scan. The Scan application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Scan application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters  

Setup dialog box | Cary page  

a Set the ‘Data Mode’ to Bio-/Chemi-luminescence. 
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b Click the Options button to display the ‘Bio-/Chemi-
luminescence Options’ dialog box. Enter the ‘Gate Time’ as 
200 milliseconds. The ‘Gate Time’ is the overall reading time 
of the emission signal and is typically set to between 100 and 
500 milliseconds. 

c Click OK to close the ‘Bio-/Chemi-luminescence Options’ 
dialog box and return to the ‘Cary’ page.  

NOTE Under „Scan setup‟, the „Excitation‟ and „Synchronous‟ options are unavailable 

as the lamp does not flash for a Bio-/Chemi-luminescence scan. Therefore, it is 

set to „Emission‟ mode. 

 

d Set the ‘X mode’ to Wavelength (nm). 

e Enter a ‘Start’ value of 300 nanometers and enter a ‘Stop’ 
value of 750 nanometers. The ‘Start’ value should be set to 
the ‘Excitation’ value plus the sum of the slits. 

f Enter an ‘Emission slit’ value of ‘10’. Slits determine the 
resolution of the spectrum and therefore are used in 
conjunction with the ‘PMT Detector Voltage’ (set on the 
‘Options’ page) to determine concentration.  

4 Set up visual system monitoring  

Select the Status Display check box so that you can view various 
instrument parameters during the scan. 

5 Set up the display, signal-to-noise, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab to display the ‘Options’ page. 

b Under ‘Display Options’, select the Overlay traces check box 
to overlay the results of the traces on one graph. 

c Select the CAT or S/N mode option. If this option is not 
available, clear the ‘Cycle mode’ and/or ‘Smoothing’ check 
boxes. 

d Set the ‘Mode’ to S/N mode. You will be informed that the 
‘Scan control’ on the ‘Cary’ page will be set to ‘Manual’. Click 
OK to continue. 
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e Set the ‘S/N’ value to ‘600’ and the ‘Time out (s)’ value to 
‘1.000’. The Cary Eclipse instrument will control the 
‘Averaging Time’ by waiting at each data point and averaging 
the signal until the value set in the ‘S/N’ field is obtained. 
This parameter is useful if you have areas of low 
transmission in your scan and wish to have the same level of 
‘noise’ across the whole scan. 

f Set the ‘Emission filter’ to Open in order to minimize steps in 
the spectra.  

g Set the ‘PMT Detector Voltage’ to High. A ‘High’ setting is 
recommended for low-emitting samples. This setting can later 
be adjusted if results are over-range. If the signal is too high, 
decrease the ‘PMT Detector Voltage’.  

6 Make sure that no accessories are selected  

Setup dialog box | Accessories page 

Make sure that no options are selected on any of the ‘Accessories’ 
page tabs. 

7 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method.  

b Enter your name in the ‘Name’ field.  

c If required, enter any comments relating to your experiment 
in the ‘Comment’ field.  

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report.  

 ‘Graph’ to include a graph in the generated report. 
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NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as displaying it in the Report area. However if „Auto 

Print‟ is not selected, the report will be displayed in the Report area only. The 

Report area can be viewed by choosing „Report‟ from the „View‟ menu. 

 

e Set up the ‘Peaks’ reporting options.  

f Select Maximum peaks to report the peak with the largest 
peak threshold that exceeds the peak ‘Threshold’ value. 

g Select All peaks to report all peaks meeting the ‘Peak type’ 
criterion and exceeding the ‘Threshold’ value. 

h Select the Peak type and specify the peak ‘Threshold’. 

i If required, select the ‘X-Y Pairs table’ check box. You can use 
the ‘Actual Data Interval’ by which the data was collected or 
you can make the Cary Eclipse ‘Interpolate’ the points to a 
new interval.  

8 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page. Use 
this page to set up whether the collected data is to be saved, 
and if so, when the Cary Eclipse should store the 
information. 

b Select the ‘Storage’ option of On; Prompt at end. 

c Select the Autoconvert option you require. If you select 
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at 
the end of the data collection the system will automatically 
generate a report and store the data both in the Cary Eclipse 
format as well as ASCII XY pairs format in the current folder. 

9 Set up e-mail options  

Refer to How to ‘e-mail your results’ on Page 121 for instructions on 
setting up the e-mail options. 
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10 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

11 Zero the instrument  

a Place the blank solution in the sample compartment of the 
Cary Eclipse instrument. 

b Click the Zero button to zero the system. Alternatively, 
choose Zero from the Commands menu to perform a zero. 
When the result is zeroed, the word ‘Zeroed’ will appear in 
the Y display box in the top left corner of the Scan 
application window. 

12 Start the run  

a Click the Start button to commence a Scan data collection. 
Alternatively, choose Start from the Commands menu. The 
‘Sample Name’ dialog box will be displayed. 

b In the ‘Sample Name’ dialog box, enter the appropriate name 
for you sample and click OK. The Scan run will commence 
and the corrected trace will appear in the Graphics area. 

13 Save your data  

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this scan run. 

c Click Save. The collected data will be stored as a Batch file. 

Perform a phosphorescence scan 

This procedure demonstrates how to perform a wavelength scan in 
phosphorescence mode. 

1 Start the Scan application  

Click the Windows Start button, point to Programs, Cary Eclipse 
and then click Scan. The Scan application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Scan application. 
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2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters  

Setup dialog box | Cary page  

a Set the ‘Data Mode’ to Phosphorescence. 

b Click the Options button to display the ‘Phosphorescence 
Options’ dialog box. The values you enter for the options in 
this dialog box depend upon the sample you are scanning. 
For example, if you were analyzing a sample such as 
Europium (Eu3+), which has a short decay time, it is 
recommended that you enter the following values:  

 Total decay time: 0.005 s 

 No. of flashes: 1 

 Delay time: 0.100 ms 

 Gate time: 1.0 ms 

However, if you were analyzing a sample such as naphthalene, which 
is known to have a phosphorescence lifetime in the seconds regime, 
it is recommended that you enter the following values: 

 Total decay time: 2 s 

 No. of flashes: 10 

 Delay time: 0.100 ms 

 Gate time: 500 ms 

c Once you have entered the values in the ‘Phosphorescence 
options’ dialog box, click OK to close the dialog box and 
return to the ‘Cary’ page. 

d Set the ‘Scan setup mode’ to Emission. During the emission 
scan, the excitation monochromator is set to a fixed 
wavelength and the emission monochromator is scanned 
over a wavelength range. 
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e Set the ‘X mode’ to Wavelength (nm). Set the following 
parameters for europiumIII: 

Parameter Value (nm) Guidelines 

Excitation 340 The „Excitation‟ value must be within the region where the phosphorescent 

molecule to be scanned will absorb light. 

Excitation 

slit 

20 Slits determine the resolution of the spectrum and therefore are used in 

conjunction with the „PMT Detector Voltage‟ (set on the „Options‟ page) to 

determine concentration. If a compound is not highly phosphorescent (as is 

the case for Europium) the slits need to be set quite wide. 

Emission 

slit 

20  

Start 360 The „Start‟ value should be set to the „Excitation‟ value plus the sum of the 

slits. In this example, as the „Excitation‟ value is 340 nm, and the sum of the 

slits is 20 nm, The „Start‟ value is set to 360 nm. 

Typically phosphorescence samples should be scanned to above 600 nm, and 

preferably to between 700–750 nm, even if they fluoresce at as low as 

300 nm. 

Stop 700–750  

Set the following parameters for naphthalene: 

Parameter Value (nm) Guidelines 

Excitation 290 The „Excitation‟ value must be within the region where the phosphorescent 

molecule to be scanned will absorb light. 

Excitation 

slit 

10 Slits determine the resolution of the spectrum and therefore are used in 

conjunction with the „PMT Detector Voltage‟ (set on the „Options‟ page) to 

determine concentration. If a compound is not highly phosphorescent (as is 

the case for Europium) the slits need to be set quite wide. 

Emission 

slit 

20  

Start 310 The „Start‟ value should be set to the „Excitation‟ value plus the sum of the 

slits. In this example, as the „Excitation‟ value is 340 nm, and the sum of the 

slits is 20 nm, The „Start‟ value is set to 360 nm. 

Typically phosphorescence samples should be scanned to above 600 nm, and 

preferably to between 700–750 nm, even if they fluoresce at as low as 

300 nm. 

Stop (nm) 800  
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f If selected, clear the ‘3-D Mode’ check box.  

4 Set up visual system monitoring  

Select the Status Display check box so that you can view various 
instrument parameters during the scan. 

5 Set up the display, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab to display the ‘Options’ page. 

b Under ‘Display Options’, select the Overlay traces check box 
to overlay the results of the traces on one graph. 

c If selected, clear the ‘CAT or S/N Mode’, ‘Cycle Mode’ and 
‘Smoothing’ check boxes. 

d Set the ‘Excitation filter’ to Auto. This will automatically 
move the filter wheel to the appropriate position for the 
selected excitation wavelength. 

e Set the ‘Emission filter’ to Open in order to minimize steps in 
the spectra.  

f Set the ‘PMT Detector Voltage’ to High. A ‘High’ setting is 
recommended for low-emitting samples. This setting can later 
be adjusted if results are over-range. If the signal is too high, 
decrease the ‘PMT Detector Voltage’.  

6 Make sure that no accessories are selected  

Setup dialog box | Accessories page 

In this example we are not using any accessories, so ensure that no 
options are selected on any of the ‘Accessories’ page tabs. 

7 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method.  

b Enter your name in the ‘Name’ field.  

c If required, enter any comments relating to your experiment 
in the ‘Comment’ field.  

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 
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 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report.  

 ‘Graph’ to include a graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as displaying it in the Report area. However if „Auto 

Print‟ is not selected, the report will be displayed in the Report area only. The 

Report area can be viewed by choosing „Report‟ from the „View‟ menu. 

 

e Set up the ‘Peaks’ reporting options.  

f Select Maximum peaks to report the peak with the largest 
peak threshold that exceeds the peak ‘Threshold’ value. 

g Select All peaks to report all peaks meeting the ‘Peak type’ 
criterion and exceeding the ‘Threshold’ value. 

h Select the Peak type and specify the peak ‘Threshold’. 

i If required, select the ‘X-Y Pairs table’ check box. You can use 
the ‘Actual Data Interval’ by which the data was collected or 
you can make the Cary Eclipse ‘Interpolate’ the points to a 
new interval.  

8 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page. Use 
this page to set up whether the collected data is to be saved, 
and if so, when the Cary Eclipse should store the 
information. 

b Select the ‘Storage’ option of On; Prompt at end. 

c Select the Autoconvert option you require. If you select 
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at 
the end of the data collection the system will automatically 
generate a report and store the data both in the Cary Eclipse 
format as well as ASCII XY pairs format in the current folder. 

  



How To 

104 Cary Eclipse Software Manual 

9 Set up e-mail options  

Refer to How to ‘e-mail your results’ on Page 121 for instructions on 
setting up the e-mail options. 

10 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

11 Zero the instrument  

NOTE This step is only necessary if there is background phosphorescence. 

 

NOTE You MUST close the sample compartment before starting a phosphorescence 

scan, as phosphorescence scanning is not immune to room light. 

 

a Place the blank solution in the sample compartment of the 
Cary Eclipse instrument. 

b Click the Zero button to zero the system. Alternatively, 
choose Zero from the Commands menu to perform a zero. 
When the result is zeroed, the word ‘Zeroed’ will appear in 
the Y display box in the top left corner of the Scan 
application window. 

12 Start the run  

a Click the Start button to commence a Scan data collection. 
Alternatively, choose Start from the Commands menu. The 
‘Sample Name’ dialog box will be displayed. 

b Place the sample in the sample compartment of the Cary 
Eclipse instrument. 

c In the ‘Sample Name’ dialog box, enter the appropriate name 
for you sample and click OK. The Scan run will commence 
and the corrected trace will appear in the Graphics area. 

13 Save your data  

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this scan run. 
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c Click Save. The collected data will be stored as a Batch file. 

Perform a phosphorescence scan in Cycle mode 

This procedure demonstrates how to perform a phosphorescence 
wavelength scan in Cycle mode. 

1 Start the Scan application  

Click the Windows Start button, point to Programs, Cary Eclipse 
and then choose Scan. The Scan application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Scan application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters  

Setup dialog box | Cary page  

a Set the ‘Data Mode’ to Phosphorescence. 

b Click the Options button to display the ‘Phosphorescence 
Options’ dialog box. The values you enter for the options in 
this dialog box depend upon the sample you are scanning. 
For example, if you were analyzing a sample such as 
europium (Eu3+), which has a very short phosphorescence 
lifetime, it is recommended that you enter the following 
values:  

 Total decay time: 0.005 s 

 No. of flashes: 1 

 Delay time: 0.100 ms 

 Gate time: 5.000 ms 
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However, if you are analyzing a sample such as naphthalene, which is 
known to have a standard phosphorescence lifetime, it is 
recommended that you enter the following values: 

 Total decay time: 1 s 

 No. of flashes: 10 

 Delay time: 0.100 ms 

 Gate time: 5.000 ms 

c Once you have entered the values in the ‘Phosphorescence 
options’ dialog box, click OK to close the dialog box and 
return to the ‘Cary’ page. 

d Set the ‘Scan setup mode’ to Emission. During the emission 
scan, the excitation monochromator is set to a fixed 
wavelength and the emission monochromator is scanned 
over a wavelength range. 

e Set the ‘X mode’ to Wavelength (nm).  

f Enter an ‘Excitation’ value of 340 nanometers. The 
‘Excitation’ value must be within the region where the 
phosphorescent molecule to be scanned will absorb light. 

g Enter an ‘Excitation slit’ value of 10 nanometers and an 
‘Emission slit’ value of 10 nanometers. Slits determine the 
resolution of the spectrum and therefore are used in 
conjunction with the ‘PMT Detector Voltage’ (set on the 
‘Options’ page) to determine concentration. If a compound is 
not highly phosphorescent (as is the case for europium) the 
slits need to be set quite wide. 

h Enter a ‘Start’ value of 360 nanometers and enter a ‘Stop’ 
value of between 700 to 750nanometers.The ‘Start’ value 
should be set to the ‘Excitation’ value plus the sum of the 
slits. In this example, as the ‘Excitation’ value is 340 
nanometers, and the sum of the slits is 20 nanometers, The 
‘Start’ value is set to 360 nanometers. Typically 
phosphorescence samples should be scanned to above 600 
nanometers, and preferably to between 700 and 750 
nanometers, even if they fluoresce at as low as 300 
nanometers. 

i If selected, clear the ‘3-D Mode’ check box.  
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4 Set up visual system monitoring  

Select the Status Display check box so that you can view various 
instrument parameters during the scan. 

5 Set up the cycle mode, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab to display the ‘Options’ page. 

b Select the Cycle mode option. This option enables you to 
collect scans as a function of time to determine whether the 
spectrum is changing. (By contrast, the Kinetics application 
enables you to determine whether a single wavelength is 
changing over time.) 
If this option is not available, clear the ‘CAT or S/N mode’ 
check box. 

c Enter a ‘No. of scans’ value of 15 to set the number of scans 
to be performed per cell or well. 

d Enter a ‘Time’ value of ‘1.0000’ to set the interval between 
each successive scan. If the time entered is less than the time 
required to complete a scan, the scans are performed 
continuously with no delay. 

e Set the ‘Excitation filter’ to Auto. This will automatically 
move the filter wheel to the appropriate position for the 
selected excitation wavelength. 

f Set the ‘Emission filter’ to Open in order to minimize steps in 
the spectra.  

g Set the ‘PMT Detector Voltage’ to High. A ‘High’ setting is 
recommended for low-emitting samples. This setting can later 
be adjusted if results are over-range. If the signal is too high, 
decrease the ‘PMT Detector Voltage’.  

6 Make sure that no accessories are selected  

Setup dialog box | Accessories page 

Ensure that no options are selected on any of the ‘Accessories’ page 
tabs. 
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7 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method.  

b Enter your name in the ‘Name’ field.  

c If required, enter any comments relating to your experiment 
in the ‘Comment’ field.  

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report.  

 ‘Graph’ to include a graph in the generated report. 

NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as displaying it in the Report area. However if „Auto 

Print‟ is not selected, the report will be displayed in the Report area only. The 

Report area can be viewed by choosing „Report‟ from the „View‟ menu. 

 

e Set up the ‘Peaks’ reporting options.  

f Select Maximum peaks to report the peak with the largest 
peak threshold that exceeds the peak ‘Threshold’ value. 

g Select All peaks to report all peaks meeting the ‘Peak type’ 
criterion and exceeding the ‘Threshold’ value. 

h Select the Peak type and specify the peak ‘Threshold’. 

i If required, select the ‘X-Y Pairs table’ check box. You can use 
the ‘Actual Data Interval’ by which the data was collected or 
you can make the Cary Eclipse ‘Interpolate’ the points to a 
new interval.  
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8 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page. Use 
this page to set up whether the collected data is to be saved, 
and if so, when the Cary Eclipse should store the 
information. 

b Select the ‘Storage’ option of On; Prompt at end. 

c Select the Autoconvert option you require. If you select 
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at 
the end of the data collection the system will automatically 
generate a report and store the data both in the Cary Eclipse 
format as well as ASCII XY pairs format in the current folder. 

9 Set up e-mail options  

Refer to How to ‘e-mail your results’ on Page 121 for instructions on 
setting up the e-mail options. 

10 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

11 Zero the instrument  

NOTE You MUST close the sample compartment before starting a phosphorescence 

scan, as phosphorescence scanning is not immune to room light. 

 

a Place the blank solution in the sample compartment of the 
Cary Eclipse instrument. 

b Click the Zero button to zero the system. Alternatively, 
choose Zero from the Commands menu to perform a zero. 
When the result is zeroed, the word ‘Zeroed’ will appear in 
the Y display box in the top left corner of the Scan 
application window. 

12 Start the run  

a Click the Start button to commence a Scan data collection. 
Alternatively, choose Start from the Commands menu. The 
‘Sample Name’ dialog box will be displayed. 
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b In the ‘Sample Name’ dialog box, enter the appropriate name 
for you sample and click OK. The ‘Sync Start’ dialog box will 
be displayed. 

c The ‘Sync Start’ dialog box displays a two minute countdown 
in seconds. If you want to start your data collection before 
the two minute countdown ends, add your active reagent and 
click ‘OK’. Alternatively, you can add your active reagent and 
wait for the countdown to end. The data collection will 
automatically start. 

13 Save your data  

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this scan run. 

c Click Save. The collected data will be stored as a Batch file. 

Perform a phosphorescence scan in Signal-To-Noise mode 

This procedure demonstrates how to perform a phosphorescence 
wavelength scan in Signal-To-Noise mode. 

1 Start the Scan application  

Click the Windows Start button, point to Programs, Cary Eclipse 
and then choose Scan. The Scan application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Scan application. 

 

2 Set up data collection parameters  

Setup dialog box 

Click Setup to display the ‘Setup’ dialog box and specify the 
parameters for a new method. 

3 Set up instrument parameters 

Setup dialog box | Cary page  

a Set the ‘Data Mode’ to Phosphorescence. 
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b Click the Options button to display the ‘Phosphorescence 
Options’ dialog box. The values you enter for the options in 
this dialog box depend upon the sample you are scanning. 
For example, if you were analyzing a sample such as 
europium (Eu3+), which has a very short phosphorescence 
lifetime, it is recommended that you enter the following 
values:  

 Total decay time: 0.005 s 

 No. of flashes: 1 

 Delay time: 0.100 ms 

 Gate time: 5.000 ms 

However, if you are analyzing a sample such as naphthalene, which is 
known to have a standard phosphorescence lifetime, it is 
recommended that you enter the following values: 

 Total decay time: 1 s 

 No. of flashes: 10 

 Delay time: 0.100 ms 

 Gate time: 5.000 ms 

c Once you have entered the values in the ‘Phosphorescence 
options’ dialog box, click OK to close the dialog box and 
return to the ‘Cary’ page. 

d Set the ‘Scan setup mode’ to Emission. During the emission 
scan, the excitation monochromator is set to a fixed 
wavelength and the emission monochromator is scanned 
over a wavelength range. 

e Set the ‘X mode’ to Wavelength (nm). 

f Enter an ‘Excitation’ value of 340 nanometers. The 
‘Excitation’ value must be within the region where the 
phosphorescent molecule to be scanned will absorb light. 
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g Enter an ‘Excitation slit’ value of 10 nanometers and an 
‘Emission slit’ value of 10 nanometers. Slits determine the 
resolution of the spectrum and therefore are used in 
conjunction with the ‘PMT Detector Voltage’ (set on the 
‘Options’ page) to determine concentration. If a compound is 
not highly phosphorescent (as is the case for europium) the 
slits need to be set quite wide. 

h Enter a ‘Start’ value of 360 nanometers and enter a ‘Stop’ 
value of between 700 and 750 nanometers. The ‘Start’ value 
should be set to the ‘Excitation’ value plus the sum of the 
slits. In this example, as the ‘Excitation’ value is 340 
nanometers, and the sum of the slits is 20 nanometers, The 
‘Start’ value is set to 360 nanometers. Typically 
phosphorescence samples should be scanned to above 600 
nanometers, and preferably to between 700 and 750 
nanometers, even if they fluoresce at as low as 300 
nanometers. 

i If selected, clear the ‘3-D Mode’ check box.  

4 Set up visual system monitoring  

Select the Status Display check box so that you can view various 
instrument parameters during the scan. 

5 Set up the display, signal-to-noise, filter and voltage options  

Setup dialog box | Options page  

a Click the Options tab to display the ‘Options’ page. 

b Under ‘Display Options’, select the Overlay traces check box 
to overlay the results of the traces on one graph. 

c Select the CAT or S/N mode option. If this option is not 
available, clear the ‘Cycle mode’ and/or ‘Smoothing’ check 
boxes. 

d Set the ‘Mode’ to S/N. You will be informed that the ‘Scan 
control’ on the ‘Cary’ page will be set to ‘Manual’. Click OK to 
continue. 
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e Set the ‘S/N’ value to ‘600’ and the ‘Time out’ value to ‘1.000’ 
second. The Cary Eclipse instrument will control the 
‘Averaging Time’ by waiting at each data point and averaging 
the signal until the value set in the ‘S/N’ field is obtained. 
This parameter is useful if you have areas of low 
transmission in your scan and wish to have the same level of 
‘noise’ across the whole scan. 

f Set the ‘Excitation filter’ to Auto. This will automatically 
move the filter wheel to the appropriate position for the 
selected excitation wavelength. 

g Set the ‘Emission filter’ to Open in order to minimize steps in 
the spectra.  

h Set the ‘PMT Detector Voltage’ to High. A ‘High’ setting is 
recommended for low-emitting samples. This setting can later 
be adjusted if results are over-range. If the signal is too high, 
decrease the ‘PMT Detector Voltage’.  

6 Make sure that no accessories are selected  

Setup dialog box | Accessories page 

Ensure that no options are selected on any of the ‘Accessories’ page 
tabs. 

7 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Click the Reports tab to display the ‘Reports’ page, where 
you can specify your reporting requirements for this method.  

b Enter your name in the ‘Name’ field.  

c If required, enter any comments relating to your experiment 
in the ‘Comment’ field.  

d Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select: 

 ‘Auto Print’ to automatically obtain a printout of your report.  

 ‘Parameters’ to include your experimental parameters in the 
report.  

 ‘Graph’ to include a graph in the generated report. 
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NOTE If „Auto Print‟ is selected, the system will send the report information to the 

specified printer as well as displaying it in the Report area. However if „Auto 

Print‟ is not selected, the report will be displayed in the Report area only. The 

Report area can be viewed by choosing „Report‟ from the „View‟ menu. 

 

e Set up the ‘Peaks’ reporting options.  

f Select Maximum peaks to report the peak with the largest 
peak threshold that exceeds the peak ‘Threshold’ value. 

g Select All peaks to report all peaks meeting the ‘Peak type’ 
criterion and exceeding the ‘Threshold’ value. 

h Select the Peak type and specify the peak ‘Threshold’. 

i If required, select the ‘X-Y Pairs table’ check box. You can use 
the ‘Actual Data Interval’ by which the data was collected or 
you can make the Cary Eclipse ‘Interpolate’ the points to a 
new interval.  

8 Set up storage of collected data  

Setup dialog box | Auto Store page  

a Click the Auto Store tab to display the ‘Auto Store’ page. Use 
this page to set up whether the collected data is to be saved, 
and if so, when the Cary Eclipse should store the 
information. 

b Select the ‘Storage’ option of On; Prompt at end. 

c Select the Autoconvert option you require. If you select 
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at 
the end of the data collection the system will automatically 
generate a report and store the data both in the Cary Eclipse 
format as well as ASCII XY pairs format in the current folder. 

9 Set up e-mail options  

Refer to How to ‘e-mail your results’ on Page 121 for instructions on 
setting up the e-mail options. 
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10 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

11 Zero the instrument  

NOTE You MUST close the sample compartment before starting a phosphorescence 

scan, as phosphorescence scanning is not immune to room light. 

 

a Place the blank solution in the sample compartment of the 
Cary Eclipse instrument. 

b Click the Zero button to zero the system. Alternatively, 
choose Zero from the Commands menu to perform a zero. 
The system will perform an instrument zero on the blank 
solution. When the result is zeroed, the word ‘Zeroed’ will 
appear in the Y display box in the top left corner of the Scan 
application window. 

12 Start the run  

a Click the Start button to commence a Scan data collection. 
Alternatively, choose Start from the Commands menu. The 
‘Sample Name’ dialog box will be displayed. 

b Place the sample in the sample compartment of the Cary 
Eclipse instrument. 

c In the ‘Sample Name’ dialog box, enter the appropriate name 
for you sample and click OK. The Scan run will commence 
and the corrected trace will appear in the Graphics area. 

13 Save your data  

a Once the run is finished, choose Save As from the File menu. 

b Enter a ‘File name’ for this scan run. 

c Click Save. The collected data will be stored as a Batch file. 
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Simple Reads 

The following Simple Reads procedures are described: 

 Performing a measurement at a single wavelength 

 Performing measurements at two wavelengths and subtracting 
the result 

Perform a measurement at a single wavelength 

This procedure demonstrates how to read samples at a single 
wavelength. Follow the steps, adjusting them to meet the 
requirements of your particular data collection.  

1 Start the application 

a On the Windows taskbar click Start, then point to Programs, 
Cary Eclipse and choose Simple Reads. The Simple Reads 
application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Simple Reads application. 

 

b Make sure that the sample compartment is clear (or you have 
a blank in position) and zero the instrument by clicking the 
Zero button. 

2 Set up instrument parameters 

a Click the Setup button or choose Setup from Menu line to 
display the ‘Cary’ page of the ‘Setup’ dialog box. 

b Under ‘Instrument Setup’, select the ‘Data Mode’ you require. 
Choose from ‘Fluorescence’, ‘Bio-/Chemi-luminescence’ or 
‘Phosphorescence’. 

c Under ‘Wavelength Setup’, enter the required excitation and 
emission wavelengths at which you want to perform the read. 

d Click OK. The instrument will change to the new wavelength. 

3 Read the sample 

a Insert the sample into the sample compartment. 
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b Wait while the instrument changes to the specified 
wavelength. The current wavelength is displayed in the 
‘Intensity’ status display at the top and right of the 
application window. 

c Click the Read button to perform the read. The result will be 
displayed in the Report area.  

4 Print the results 

To print the contents of the Report area, click the Print button. 

Perform measurements at two wavelengths and subtract the result 

With the User Collect function, you can extend the Simple Reads 
application to carry out simple mathematical functions on the results 
of readings performed on a sample at various wavelengths. 

To do this:  

1 Start the application 

a On the Windows taskbar click Start, then point to Programs, 
Cary Eclipse and choose Simple Reads. The Simple Reads 
application will open. 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Simple Reads application. 

 

b Make sure that the sample compartment is clear (or you have 
a blank in position) and zero the instrument by clicking the 
Zero button. 

2 Set up instrument parameters 

a Click the Setup button or choose Setup from the Menu line to 
display the ‘Cary’ page of the ‘Setup’ dialog box. 

b Under ‘Instrument Setup’, select the ‘Data Mode’ you require. 
Choose from ‘Fluorescence’, ‘Bio-/Chemi-luminescence’ or 
‘Phosphorescence’. 
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c Select User Collect. The ‘Em. Wavelength’ field will change to 
enable you to enter a simple Read command. You can also 
select a default command from the drop-down list. To do this, 
click the arrow to the right of this field. 

User collect example: 

Read(340, 400)-Read(340, 450) 
This reads the intensity at Excitation monochromator = 340, 
Emission monochromator = 400 and subtracts the intensity read at 
Excitation monochromator = 340 and Emission monochromator = 
450. This reading is performed at each data point. 

d Set the slit widths of the excitation and emission 
monochromators in the ‘Ex. Slit’ and ‘Em. Slit’ fields. 

e Enter the averaging time, which is the time for which data is 
averaged. 

f Click OK. The User Collect statement will appear in the 
Report area. 

3 Read the sample 

a Insert the sample into the sample compartment. 

b Click the Read button to perform photometric measurements 
on the sample at the specified wavelength. 

c The value for each sample read will appear in the Report 
area as well as the result of the User Collect equation.  

4 Print your results 

To print the contents of the Report area, click the Print button. 
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Perform a Validation run 

1 Start the Validate application  

On the Windows taskbar, click the Start button, point to Programs, 
Cary Eclipse and then choose Validate. The Validate application will 
open. 

(Alternatively, you can double-click the ‘Validate’ button in the Cary 
Eclipse folder on the desktop.) 

NOTE If you are running a GLP system, you may be prompted to enter a password 

before accessing the Validate application. 

 

2 Set up test parameters 

a From the Validate application, click the Tests button to open 
the ‘Tests’ dialog box. The ‘Configure’ page will be displayed. 

b On the ‘Configure’ page, ensure that the Auto Excitation 
PMT voltage option is selected. Selecting this option enables 
the instrument to set the optimum photomultiplier voltage 
for the system. The voltages used during the test will be 
displayed on the report. 

c Select the type of instrument performance tests that you 
require. The various tests that are available will appear as 
tabs across the top of this dialog box. 

If your access privileges are restricted by the GLP application 
you may find that fields and buttons in this dialog box are 
unavailable. See your administrator to gain access. 

d Click each tab and select the tests that you require to be 
performed by selecting the appropriate check boxes. 

e Change any parameters that you require to be changed to suit 
your laboratory in each test. 

f If you wish to save the tests you have set up for future use, 
choose Save Method As from the File menu. The ‘Save As’ 
dialog box will be displayed to enable you to the method with 
a *.fmvo file name extension. 
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3 Start the run 

a Click the Start button or choose Start from the Commands 
menu to commence the Validate testing procedure. 

b Follow the instructions on the prompts that appear and click 
OK to continue with the performance tests. 

You can click the Cancel button at any time to stop the Validate run. 

NOTE The Validate application will automatically arrange the tests so that tests 

requiring your intervention (for example, placing filters or solutions into the 

sample compartment) are performed early in the Validate run. Tests that do not 

require your intervention will be performed later in the run. The system will 

advise you when you are no longer required. However, you can change the 

order of the tests if you require. 

 

The results for each test are displayed in the Report area 
immediately after the test is completed. 

4 After the run 

At the end of the Validate run, the Cary Eclipse system automatically 
generates a report file. The report file is stored the "Cary Eclipse 
WinFLR" directory. 

The Report file will be saved with the following format: 

DATE TIME.FRVO 

For example, 

16 Apr 00 3;57;48 PM.FRVO 

The date and time will appear in the same form that is set in the 
Windows Regional Settings Properties dialog box, accessed from the 
Windows Control Panel. 

At the end of the Validate run, you can also save your data. To do 
this, choose Save As from the File menu. The ‘Save As’ dialog box 
will be displayed to enable you to save the current method, data and 
report in a batch file (*.fbvo). 
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E-mail your results 

You may wish to send an e-mail to a person once the read is 
completed. This useful facility can be used to alert you to the 
completion of the read, particularly if you are working away from the 
laboratory where the Cary Eclipse instrument is located. 

To do this: 

1 Ensure that you have set up the ‘Host’ and ‘Port’ options on the 
‘E-mail options’ page of the System Information application in 
order for the e-mail facility to correctly work. 

2 From the Setup menu of the application you are using, choose 
Auto Store. The ‘Auto Store’ page will be displayed. 

3 Select the E-mail check box to enable the e-mail options. 

4 In the ‘To’ field, enter the recipient’s e-mail address (for example, 
anne.person@agilent.com). To enter multiple recipients, type a 
comma ‘,’ in between each e-mail address. 

5 In the ‘From’ field, enter the e-mail address of the computer on 
which the Cary Eclipse software is installed. This may be your e-
mail address, or a communal e-mail address if the Cary Eclipse 
software is installed on a computer that has multiple users. 

6 Enter information in the ‘Subject’ and ‘Message’ fields as 
required. 

7 Select Attach current data. The data that has been collected 
during the run will be attached to the e-mail. 

TIP You can attach other documents to your e-mail. To do this, click the „Attached‟ 

button and browse your computer to select a file, using the displayed Windows 

„Open‟ dialog box. 

 

8 Click OK to clear the ‘Auto Store’ dialog box. Your e-mail will be 
sent once the run has been completed. 
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5. Troubleshooting 

Instrument offline 124 

Connect button instead of Start 124 

Poor display of videos and photographs  125 

GLP log does not list some privilege changes 125 

Report header and footer not being updated  126 
 

To troubleshoot installation and startup problems, check the 
information in this chapter. If you still have not found a solution to 
your problem, check the ‘Troubleshooting’ section in the hardware 
manual supplied with the instrument. 

If you are having problems with your software, check the information 
in this chapter to see if there is a solution to your problem. You may 
also find a solution to your problem in the: 

 ‘Troubleshooting’ section of the online Help. To view this, click 
the Windows ‘Start’ button, then ‘Programs’, ‘Cary Eclipse’, and 
‘Cary Eclipse Help’. Click ‘Troubleshooting’ and follow the links. 

 Late Breaking News documents that were shipped with the Cary 
Eclipse software. 

If you still have not found the solution to your problem, contact your 
local Agilent office or representative. 
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Instrument offline 

Problem 

When I start the Cary Eclipse software, the application reports that 
the instrument is ‘Offline’. 

Solutions 

 Check the connection of the main instrument cable attaching the 
computer to the instrument. 

 Ensure the instrument has completed its initialization tests 
before you start the Cary Eclipse software.  

For more information, refer to the hardware manual provided with 
the instrument. 

Connect button instead of Start 

Problem 

When I start the Cary Eclipse application, I want to use the ‘Start’ 
button but it has changed to a ‘Connect’ button — why? 

Solution 

When you first start the Cary Eclipse software, the System 
Information application has control of the instrument while it 
initializes. Until the initialization has finished, any other application 
that you start will not have control of the instrument; hence the 
‘Connect’ button. Wait until the ‘Connect’ button changes to ‘Start’. If 
it does not change, check to see if you have any other Cary Eclipse 
applications running. If they are not collecting data, you can just 
click the ‘Connect’ button to get control of the instrument. 
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Poor display of videos and photographs 

Problem 

The graphics and video display appears fuzzy, grainy or in weird 
colors. 

Solution 

Increase your display settings to a higher resolution. 

To do this: 

1 Click the Windows Start button then Settings, Control Panel 
and double-click Display. 

2 Click the Settings tab and adjust the color palette to a higher 
screen resolution (that is, 16 bit or 32 bit color), providing your 
monitor and display adapter allow it. 

3 Click OK. 

NOTE You may have to restart your computer for the settings to take effect. 

 

GLP log does not list some privilege changes 

Problem 

I have changed multiple privileges using the GLP application, but not 
all of them appear in the log file that the application creates, what 
has happened? 

Solution 

You need to click the ‘Apply changes now’ button on the ‘Privileges’ 
page each time you change privileges for a user or application. You 
cannot make multiple changes and then click the ‘Apply Changes 
now’ button — the changes are actually made but they don’t appear in 
the log. 
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Report header and footer not being updated 

Problem 

I have changed the report header and footer information in the 
System Information application but it is not being updated when I 
generate a report — why? 

Solution 

If you are using Windows NT, you need to be logged on as an 
Administrator to make the changes in System Information. 


